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1. About FMEA in Teamcenter

Failure Mode and Effects Analysis (FMEA) is a methodology to identify and optimize the risk involved
at the design or the manufacturing stage. You can use Teamcenter to predict different failure modes
for a product design or a process at the initial stage itself so that appropriate actions can be taken
for preventing them. This avoids defects prior to production, improves functional safety, and reduces
warranty claims and costs.

There are two types of FMEA — Design FMEA (D-FMEA) and Process FMEA (P-FMEA). The three main
phases of FMEA are identifying what can go wrong, analyzing the chances of a failure mode and its
consequences, and taking actions to mitigate the cause and reduce its risk priority value.

Teamcenter helps you to perform FMEA using the following phases:
* Planning and preparation

* Structure analysis

* Function analysis

* Failure analysis

* Risk analysis

* Optimization analysis

* Results documentation using formsheets

Example:

Consider the air intake system of a car engine. One of the components, the air filter is prone to
wear and tear. If the air filter tears, unfiltered air can enter the engine. This potential failure of
the air filter can affect the performance of the car engine or cause it to fail. You can use FMEA

to analyze the function of each component in the air intake assembly. You can identify and add
potential failures, such as the breakdown of the air filter, and assess the causes and effects of this
failure. After the analysis, you can recommend prevention and detection actions to minimize the
risks.
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_ 1. About FMEA in Teamcenter

Teamcenter

Quality

Avoid defects prior to production,
improve functional safety and product
reliability, and reduce warranty
claims and costs.

Create, execute, and track quality-
related tasks, such as reacting to
critical questions in a checklist,
applying corrective and preventative
actions in a problem-solving process,
and so on.

Create a Control Plan to track what

Quality
Project
Management

Awvoid risks by creating quality
plans upfront and anticipating
failure points at each stage of
the development phase.

Manage quality issues from
internal sources, suppliers, or
customers.

Quality Training Capture varicus forms of issuesin a
operations need to be inspected and Audit and central location, find the root cause
the quality inspection characteristics Qualification of the issues, its resolution, and

(process and product related) that are
required in the production process.

Plan, schedule, execute, and track
audits and assessments.

and gauges.

prevent their recurrence in the future.

Manage the training and qualification
requirements of people, equipment,
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Where do | go from here?
@ Administrator

- Administrator

~ .
Py Business User

How can | analyze failure modes for a product or
a process design in Teamcenter?

Is it necessary to create catalogs for users? Who
creates these?

What are the steps involved in performing FMEA
in Teamcenter?

Can | create variants of an existing FMEA
structure?

After performing the FMEA, how can | track
other quality-related tasks and the identified
issues?

To know which features are required to install
FMEA, see Install FMEA.

To attach the configuration file to guideline
objects, or to modify the guideline values, see
What are FMEA guideline objects.

To customize the FMEA formsheet, see
Customizing formsheets.

To analyze different failure modes for a product
or a process design at the initial stage itself

so that appropriate actions can be taken to
prevent them, you can perform a structure
analysis, function analysis, failure analysis,
risk analysis, and optimization analysis.

The FMEA master data is created as a hierarchy
of items by a designated user. These help the
FMEA engineer to search for and locate items
while creating function specifications and failure
specifications.

To learn about how to perform the risk
assessment for a product or a process design in
Teamcenter, see FMEA workflow process.

After you create an FMEA structure, you can use
it as a reference and create a new variant with
a few modifications. To learn about creating
FMEA variants, see Create variants of a master
FMEA. You can also compare and align FMEA
structures if required.

To know more about how to create, execute,
and track the recommended prevention or
detection actions, and other quality-related
tasks, see the information in Quality Actions.

To investigate a potential problem that must be
addressed, you can capture it as an issue. For
more information on how to do this, see Quality
Issues.

To know about how to generate a control plan
from an existing FMEA, see the information in
Control Plans
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_ 1. About FMEA in Teamcenter

Note:

A separate license is required for Quality
Actions, Quality Issues, and Control
Plans respectively.
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2. FMEA task flow in Teamcenter

Quality Mas ter

FMEA Engineer Data Engineer

Create and manage the
Quality master data
through out the lifecydle

Create an FMEA for planning &
preparation and identify the cross-
functional team

¥
Perfi struct Iy si Refer Syst I t fficati
erform a structure analysis =~ ——- . . - —= System element specfication
Y
Peri functi aly si Fefer Functi ificati
erfarm a function analysis == aster et - unction specification
L
: : Refer : S
Perform a failure analysis — = 1 —- Failure specification
master dala
L

Perform a risk analysis

Y
Optimize risks by identifying

recommended actions Quality Manager

¥

Communicate risksvia Reporting

L4

Review and approve the FMEA

R through a release workflow

——  (Create aversion of the FMEA

&

Supported Mot suppored
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3. Access the FMEA tile in the Quality
Management workspace

The Quality Management workspace is a workspace dedicated to working with Teamcenter Quality
applications. The FMEA tile in the Quality Applications section in the Quality Management workspace
has options specifically for working in FMEA.

You can:

* View any open or released FMEAs on the respective tabs.

* View the dashboard for FMEA including the quality master data.

 Search for and filter your search results as required.

* Segregate the FMEA data and view specific charts using the options in the Chart by list.

* Access other applications, such as Assistant, Discussions, Programs, and Schedules, on the global
navigation toolbar.

@

Teamcenter

31 results found for “Open” G

FMEA ©Open Released Dashboard 2 ', @ No Active ECNl .’,‘_.o aee e SIEMENS
Si

Quality
. v — Selection ; Selet o | i T
) aboni e f Filters Filter Results by: Last Modifying User
Home
Er} Chart by:
A:;t.i;'tam ’O ‘ Last Modifying Usel -
%] Last Modifying User
Discussions test
Owner: Engineer,Ed (ed) Group ID
B Date Modified: 26-Apr-2024 16:42
Explorer Cwner
Tablet Press Components 8
f@ FMEA Category
Shcs Owner: Kulkarni, Mandar {ddm7tg)
Date Modified: 22-Apr-2024 03:45 EMEA Guidelines
&
Programs SM1_FMEA FMEA Type
Owner: Tcadmin, testuser (tcadmin) r—
- Date Modified: 22-Apr-2024 15:42
Changes
8 . Fmea_EditActions_ViaOvervie...
Program Owner: AW, Engineering (aw_engin...
Deliverables Date Modified: 22-Apr-2024 03:44 1 1 1 1 1
v
=b Frmea_EditActions_ViaEditSum... . . . . .
Programs
Owner: AW, Engineering (aw_engin...
Date Modified: 22-Apr-2024 03:44
Schedules

Your administrator must make the Quality Management workspace available for your organization's
groups and roles.
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_ 3. Access the FMEA tile in the Quality Management workspace

For more information about workspaces, see Learn about workspaces in Active Workspace
Customization of the Teamcenter documentation.

To access the tile for your Quality application in the Quality Management workspace:
1. Click your profile icon.

2. From the Workspace list, select Quality Management.

£ (@ Noadivetcn) A - @

e ed (ed)
User ID: ed = Manage Profile {
Project: Workspace:
Mo Project = Quality Management ~
Author
Group: )
Designer

Engineering «
Engineering BOM
Role:

] Quality Management
Designer =

Requirements Manager

Supplier
() Display session settings av e powom o e page

=+ Sign Out

3. Inthe Quality Applications section, click the FMEA tile.
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4. Manage the FMEA master data

About the FMEA master data

The FMEA master data is a collection of system element specifications, function specifications, and
failure specifications.

Typically, the Quality Master Data Engineer or the designated user creates the system element, function,
and failure specifications in the Quality Master Data Library or in any folder.

While creating the FMEA structure, you can search for specifications in the Quality Master Data

Library and add them to the FMEA structure. Alternatively, you can create the required system element
specifications, function specifications, or failure specifications and add them to the Quality Master Data
Library.

Each time the master data is edited and saved, the system creates a new version of it. This helps in
tracking all the changes made over a period of time. In addition, the master data can be deactivated so
that it cannot be further used for creating the FMEA structure.

Creating the master data provides the following benefits:
* Common quality standard within a company that can be shared by different products and processes

» Detection of unknown quality dependencies because the specifications are shared between different
products and processes

» Easy way to structure the data

* Enhancement of the quality data by using versioning. Users can see what has changed and update to
the latest version.

Create the system element specifications master data

A system element specification is a workspace object corresponding to each component, assembly, or
process you have identified for which FMEA is required. As an example, let us consider this specification
to be the air filter assembly of a car.

You can create the system element specifications master data in Folders or in the Quality Master Data
library. The Quality Engineer—while creating the FMEA structure—can search for and add them to the
FMEA structure.

After creating the system element specifications, you can edit them to specify additional properties.
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_ 4. Manage the FMEA master data

Create the system element specification master data in Folders

1.

On the HOME page, click EXPLORER, and select a folder.
Choose More Commands «s« > New - < > Add.
In the Type list, type system element, and select System Element Specification.

Specify a name (mandatory) and type a description (optional).

To add this system element specification, click Add.

Create the system element specification master data in the Quality Master Data library

Typically, the Quality Master Data Engineer or the designated user creates the system element
specifications master data in the Quality Master Data library.

1.

On the HOME page, click the QUALITY MASTER DATA tile.
Click the System Elements page.
Choose More Commands <<+ > New =< > System Element Specification.

Specify a name (mandatory) and type a description (optional).

To add this system element specification, click Add.

Specify additional properties of system element representations

You can edit the system element representations to specify additional information and properties. These
properties can help you while performing the structure analysis.

1.

2.

3.

Open the system element representation for which you want to specify additional information.
Click More Commands <.« > Edit ./ > Start Edit.

Add, update, or modify the following properties of the system element representation.

* Name

* Description

* Sequence - Specify the sequence of the system element representation in the FMEA structure.
The default value of the of the Sequence property of the first system element that you create
is 10. For the subsequent siblings that you create, the value is automatically populated in
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Create the function specifications master data _

increments of 10. You can edit the value of this property and modify the sequence of system
element representations.

* System Element Type - Specify the system element type as Process or Design.

» System Element Sub-Type - Specify if the system element subtype is Operation, Storage, Test
Characteristic, or Transportation. This property available only for the Process type of FMEAs.

* Part/ Material Number - Specify the part number from the BOM in the FMEA structure.

* Operation Number - Specify the operation number from the BOP in the FMEA structure. This
property available only for Process type of FMEAs: In the process flow chart, the system displays
specific icons for the different system element subtypes. Specifying these additional properties
can help you easily identify and categorize the types of processes in the process flow chart.

4.  Click More Commands ««« > Edit .~ > Save Edits.

Create the function specifications master data

A function specification is a workspace object corresponding to each action associated with a part in the
structure. In the context of the example of an air filter assembly of a car, one of the functions of the air
filter is providing clean and compressed air to the car engine.

You can create the function specifications master data in Folders or in the Quality Master Data library.
The Quality Engineer—while creating the FMEA structure—can search for and add them to the FMEA
structure.

After creating the function specifications, you can edit them to specify additional properties.
Create the function specification master data in Folders

1. Onthe HOME page, click EXPLORER, and select a folder.

2.  Choose More Commands s+« > New -2 > Add.

3. Type function specification in the Type list, and select Function Specification.

4. Specify a name (mandatory), type a description (optional), and click Add.

Create the function specification master data in the Quality Master Data library

A function specification master data consists of parent and child function specifications. To create the
master data, you can create a parent function specification and create child function specifications under
the parent. You can also drag and drop child function specifications from one parent to another.

1. Onthe HOME page, click the QUALITY MASTER DATA tile.
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_ 4. Manage the FMEA master data

2.  Click the Function Specifications page.
3. Choose More Commands <+« > New - ¢ > Function Specification.
4. Specify a name (mandatory), type a description (optional), and click the Add button.
5. Create a child function specification.
a. Select a function specification from the catalog.
b. Choose More Commands <.« > New - > Child.
c.  Specify a name (mandatory) and type a description (optional).
d. To create the child function specification, click Add.
Specify additional properties of function representations

You can edit the function representations to specify additional information and properties. These
properties can help you while performing the function analysis.

1. Open the function representation for which you want to specify additional information.
2. Choose More Commands -« > Edit ./~ > Start Edit.
3. Update or modify the following properties:

* Name

* Description

* Sequence - Specify the sequence of the function specification in the FMEA structure. The
default value of the of the Sequence property of the first function representation that you
create is 10. For the subsequent siblings that you create, the value is automatically populated in
increments of 10. You can edit the value of this property and modify the sequence of function
representations.

4. Choose More Commands ««« > Edit .,/ > Save Edits.

Create a failure specifications catalog

A failure specification is a workspace object for predicting potential failures. For example, in the air
filter assembly, one of the failures could be the air filter not working due to wear and tear of the filter
element.
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Create a failure specifications catalog _

You can create the system element specifications master data in Folders or in the Quality Master Data
library. The Quality Engineer—while creating the FMEA structure—can search for and add them to the
FMEA structure.

After creating the failure specifications, you can edit them to specify additional properties.
Create the failure specifications master data in Folders

1. Onthe HOME page, click EXPLORER, and select a folder.

2. Choose More Commands <.« > New - < > Add.

3. Type failure specification in the Other filter and select Failure Specification.

4.  Specify a name (mandatory) and description (optional), and click Add.

Create the failure specifications master data in the Quality Master Data Library

The failure specification master data consists of parent and child failure specifications. To create the
master data, you can create a parent failure specification and create child failure specifications under the
parent. You can also drag and drop child failure specifications from one parent to another.

1. Onthe HOME page, click the QUALITY MASTER DATA tile.
2.  Click the Failure Specifications page.
3. Choose More Commands s+« > New - < > Failure Specification.
4. Specify a name (mandatory), type a description (optional), and click Add.
5. Create a child failure specification.
a. Select a failure specification from the catalog.
b. Choose More Commands «+« > New =< > Child.
c.  Specify a name (mandatory) and type a description (optional).
d. To create the child failure specification, click Add.
Specify additional properties of failure representations

You can edit the failure representations to specify additional information and properties. These
properties can help you while performing the failure analysis.
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_ 4. Manage the FMEA master data

1. Open the failure representation for which you want to specify additional information.
2. Choose More Commands .« > Edit ./ > Start Edit.
3. Add, update, or modify the following properties:

* Name

* Description

* Sequence - Specify the sequence of the failure in the FMEA structure. The default value of
the of the Sequence property of the first failure representation that you create is 10. For the
subsequent siblings that you create, the value is automatically populated in increments of 10.
You can edit the value of this property and modify the sequence of failure representations.

4. Choose More Commands <+« > Edit .,/ > Save Edits.

Activate system element, function, or failure specifications
1. Onthe HOME page, click the QUALITY MASTER DATA tile.
2. Click the System Elements, Functions, or Failures page.
3. Click Filter 57 and under Status, select the View Inactive check box.
4. Select the specification you want to activate and click Edit.
Inactive specifications are displayed in a less opaque color.
5. To activate the specification, select the Active check box.

6. Click Save to save your changes.

Mark system element, function, or failure specifications as inactive
1. Onthe HOME page, click the QUALITY MASTER DATA tile.

2. Click the System Elements, Functions, or Failures page.

3. Select the specification you want to inactivate and click Edit.

4. To deprecate the specification, clear the Active check box.

5. Click Save to save your changes.
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Replace system element, function, or failure specifications from the representation _

By default, deprecated specifications are not displayed in the Quality Master Data library.

Replace system element, function, or failure specifications from the

representation

1.  Open the FMEA.

2. Inthe FMEA tree, select the system element, function, or failure specification that you want to
replace.

3. Inthe Overview tab, in the Specification table, select the system element, function specification,
or failure specification, and click Replace .~.

4. Inthe Replace panel, select the system element, function specification, or failure specification that
you want to replace the existing one with.

5. To update the name of the existing system element, function specification, or failure specification,
select the Update system element name based on selection check box.
If you do not select this check box, the name of the system element, function specification,
or failure specification remains the same, but the name of the associated specification object is
updated.

6. Click Replace.

Create a version of a system element, function, or failure
specification

You can create a version of a released system element, function, and failure specification.

1.

On the Home page, select the QUALITY MASTER DATA tile.
Open the system element, function, or failure specification that you want to version.
Choose More Commands <+« > Manage 3% > Submit to Workflow.

In the Submit to Workflow panel, from the Template list, select the TCM Release Process
template and click Submit to release the object.

Choose More Commands <<+ > New >/ > Version.
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_ 4. Manage the FMEA master data

Note:

This command is available only when you use the TCM Release Process workflow to release
the FMEA object.

A new version of the object is created and displayed in the Overview tab in edit mode.

Modify the name of the new version of the FMEA object and choose More Commands ««« > Edit ./
> Save Edits to save your changes.

You can view all the versions of the FMEA object in the History tab.

View the contextual information of FMEA master data

For system element specifications, function specifications, failure specifications, and quality actions, you
can view the related FMEA representations and the context where the master data is used.

Procedure

1. Onthe HOME page, click the QUALITY MASTER DATA tile.

2.  Click the System Elements, Functions, Failures, or Quality Actions page.

3. Select a system element specification, function specification, failure specification, or quality action

and click the Where Used tab.

Remove system element, function, or failure specifications from the

representation

1.  Open the FMEA.

2. Inthe Overview tab, in the Specification table, select the system element, function specification,
or failure specification.

3. Click Remove (=).

The selected object is removed.

Delete a system element, function, or failure specification

1.

2.

On the HOME page, click the QUALITY MASTER DATA tile.

Click the System Elements, Functions, or Failures page.

4-8



Delete a system element, function, or failure specification _

3. Select the specification you want to delete.
You cannot delete specifications that have child specifications.

4. Choose More Commands <+« > Edit ./ > Delete.

Failure Mode and Effects Analysis, Teamcenter 2412 4-9
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5. Create an FMEA

About FMEA in Teamcenter

You can use FMEA methodologies to predict different failure modes for a product design or a process at
the initial stage itself so that appropriate actions can be taken for preventing them. A failure mode is
essentially a cause-effect chain of events that you have not anticipated.

In Teamcenter, you can perform the analysis for the following:

Design FMEA (D-FMEA)

Design FMEA analysis is performed to analyze the various functions, failure modes, and their effects
for a new or changed design of a product. The net views, boundary diagrams, and interface
matrices help you visualize the hierarchy and detect the dependencies and interface relations
between the system element, function, and failure representations in the FMEA structure.

Process FMEA (P-FMEA)

Process FMEA analysis is performed to analyze a process flow and the various stages that a product
goes through in new or existing processes. Process flow charts show a graphical representation of
the processes at the various design stages.

Before you create the FMEA structure, it is recommended that the Quality Master Data Engineer creates
the FMEA master data in the Quality Master Data Library or in Folders.

After you create the FMEA structure, you add the various system element, function, and failure
representations to it. You can create and add new system element representations to the FMEA structure
by searching for the required objects in the Quality Master Data Library, or creating them as required.
For more information about the various tasks that you can perform to analyze designs and processes,
refer to the FMEA task flow in Teamcenter topic.

You can view the FMEA data of the system element representation such as failure effects, failure causes,
and all other related actions in the Formsheet view.

Create an FMEA

You can create an FMEA by independently by creating a hierarchy of system element representations,
function representations, and failure representations. Alternatively, you can create an FMEA from an
existing bill of materials (BOM) or bill of processes (BOP) or import the FMEA.

After creating the FMEA, you can edit it to change the FMEA guideline that was selected during creation.
You cannot change the type (design or process) of the FMEA after creation.
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_ 5. Create an FMEA

Create an FMEA

You can create the FMEA structure by creating an FMEA first and then creating a hierarchy of system
element representations, function representations, and failure representations. When you create the
FMEA, you must specify the top-level system element specification for the analysis.

1. Onthe Home page, click EXPLORER.
2. Choose More Commands <.« > New - < > Add.
3. Inthe OTHER filter, type FMEA and select FMEA.
4. Inthe Add panel, in PROPERTIES, specify the following:
a. Specify a name for the FMEA.
b.  (Optional) Type a description.
c.  Specify the FMEA guideline for the analysis.
5. In Root System Element Properties, specify the following:
a. Specify a name for the system element representation.
b. (Optional) Type a description.
6. Click Add.
The FMEA is created with the system element representation at the root node.
Create FMEA from an existing BOM or BOP
You can create an FMEA from an existing bill of materials (BOM) or bill of processes (BOP).
1. Search for a product structure (BOM) or BOP and open it.

2. To create an FMEA based on the structure opened, choose More Commands ««+ > Manage 5% >
Generate FMEA Structure.

3. Inthe Generate FMEA panel, specify a name, select the FMEA guideline type, and click Generate.
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Specify the category of an FMEA _

Note:

If you are generating large FMEA structures, you can select the Run in Background check
box, to continue running the FMEA generation process in the background. You will receive an
alert when the FMEA generation process is complete.

4.  From the Home folder, open the FMEA.
The FMEA structure opens in the tree view.
The system element name of the generated FMEA is the same as that of the product structure.
Import an FMEA
1. Onthe Home page, click EXPLORER.
2. Choose More Commands <+« > New - < > Import FMEA.
3. Inthe Import FMEA panel, click Choose File and browse to select the file that you want to import.
You can import XML files only in the MSR format.
4.  From the FMEA Guidelines list, select the required guideline.
5. Click Import.

The FMEA is imported in the specified folder.

Specify the category of an FMEA

After you create the FMEA, you can edit the FMEA properties and specify the FMEA category. You can
specify the FMEA as master, variant, or generic.

1. Open the FMEA for which you want to specify the category.

2. Choose More Commands ««« > Edit ./ > Summary.

3. Inthe Overview tab, from the FMEA Category list, select Master, Generic, or Variant.
To create a variant of an FMEA, you must specify it as a Master FMEA.

4.  Click More Commands .+« > Edit ./ > Save Edits to save your changes.
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Copy an FMEA

1.

Open the FMEA structure that you want to copy.

Choose More Commands «s« > New - < > Save As.

In the Save As panel, modify the current name, description, and FMEA guideline object if required.
Specify if you want to copy the cross-functional team.

Click Save.

A copy of the FMEA structure is created in the Newstuff folder with a copy of all system elements,
function representations, and failure representations (along with all the relations of cause and
effect) and actions under it.

* All the representations and the FMEA structure are created with version 1.
* All the actions are created with the same status as that of the parent FMEA.

* If the failure cause or effect in the source FMEA is a failure specification, then a new relation is
created with the copy of failure mode inside the new FMEA.

* If the next higher-level or lower-level function in the source FMEA is a function specification,
then a new relation is created with the copy of the function mode inside the new FMEA.

* Inspection definitions and requirements linked to the selected FMEA structure are also linked to
newly created FMEA structure.

* If the parent FMEA was generated from an item structure, the copy is also linked to the item
structure. The configuration of the FMEA refers to the configuration of the parent FMEA and not
to the global configuration of the item structure.

Create a link between FMEAs

About linking FMEAs

You can link different design or process FMEAs. This helps you to connect FMEA structures or processes
that are related to each other.

When you link FMEAs, you can create a link to an FMEA at a higher or lower level of the current FMEA.

A £ icon next to the FMEA name indicates that the FMEA is linked to other FMEAs.
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While saving linked FMEAs, you can carry forward any existing linkages of the current FMEA. To do this,
in the Save As panel, make sure that you select the Include FMEA Linkages check box.

The FMEA linkages are retained when you create a variant of an FMEA, release an FMEA, or import or
export an FMEA that is linked.

Note:

* You cannot create circular linkages between FMEAs.
* You cannot link FMEAs that are already in the released state.

* When you release an FMEA, and if it is linked to another FMEA, each FMEA must be released

independently.
L . . (@ No Active ECN )
Air Intake System Design FMEA V2 | & £ (@ NoAdiveECN,
@ Owner: Engineer,Ed (ed) Date Modified: 29-Apr-2024 More... Air Intake System Desi... rr_"‘
Search
[ Select FMEA . .
v g Tree v /2% L Fnd A e "** Air Intake System Design FMEA V2 & oo
ul L
Component. Owner: Engineer,Ed (ed) Date Modified: 29-Apr-2024 More...
n Name % §83 ~
e - :: Air Intake System Design FMEA V2 Overview  History | FMEA Linkages |FMEA Variants  Attachments >
53 - % Air Intake System i .
- o Apply Open R Sho Sha r = Full
Assistant Layout D{g Legend E? in... e Outgoing Coming L Jscreen
% 4 f(@ Supply Clean and compress the ambient air s
Discussions f(@ CRF1
&
E ] Connecting Hose Air Intake System Design FMEA
Explorer h :::VZ
» Owner: Engineer,Ed (ed)
@ Qi“} Turkocharger Date Modified: 29-Apr-2024 17:25
Inbo
oox 4 % Intake Snorkel 1
Pro%ms 4 Q» Air Filter Assembly
2\ 4 % Intake Manifold
Changes — FMEA-000000016
4 &, | External Failures ::::c\-.-new Engineer,Ed (ed)
Date Modified: 24-Apr-2024 10:52

Create a link between related FMEAs

You can create a link between design or process FMEAs and connect FMEA structures or processes that
are related to each other.

Procedure

1. Open the FMEA that you want to link to another design or process FMEA.
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2.

Access the Create FMEA Linkages command in any one of the following ways:

Click the FMEA Linkages tab, and click Create FMEA Linkages .

In the FMEA tree view, click Add > Create FMEA Linkages @.

In the FMEA tree view, right-click the FMEA root node and choose Create FMEA Linkages .
* Choose More Commands <+ > New >\ > Create FMEA Linkages .

In the Create FMEA Linkage panel, in the Input list, specify if you want to search for a design or
process FMEA, or both.

If you do not specify any filters, a list of all the FMEAs is available for selection.
Click Search to view the search results.

To specify whether you want to link the FMEA as a parent or a child of the current FMEA, select
Higher Level or Lower Level.

Select an FMEA from the search results.

You can select multiple FMEAs to link.

Click Create.

The FMEA Linkages tab shows all the FMEAs linked to the current FMEA.

The link & icon next to the FMEA name indicates that the FMEA is linked to other FMEAs.

To delete the linkages between the FMEAs, click on the link between the FMEAs tile and click
Remove.
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- . i
Cpen x_—N] Remove

Remove

; ﬁ' fmeald
ga Cwnered (88  Remove linkage between multiple FMEAs

Date Modifiey,

!

@ _.ﬁ.ir Intake System Design FMEA

l:&u.n-:-:
'3'@' Date Modified: 16-May-2023 21:41
£

Create variants of an FMEA structure

About FMEA variants

After you create an FMEA structure, you can use that FMEA as a reference and a new variant with a few
modifications. To do this, you must first specify an FMEA as a master FMEA. For more information about
how to specify an FMEA as a master FMEA, see Specify the category of an FMEA.

While creating the variant, you can select the objects that you want to include in the variant FMEA. This
reduces the time required to create an FMEA that is based on an existing FMEA. For example, PFMEA's
for different plants, DFMEA's for different parts which have common components, and so on.

Consider an air filter assembly. Since the overall purpose, design, and failure modes of the an air filter
of all car models is the same, you can create and categorize it's FMEA structure as a master FMEA and
release it. You can then create variants of this master air filter assembly FMEA structure by selecting the
objects that are relevant for a specific car model.

You can also compare the structures and properties of the master FMEA and the variant FMEA or

vice versa. After studying the differences, you can align the source and the target FMEA structures as
required. This helps you to incorporate learnings and update the master FMEAs with issues identified in
the variant FMEAs and vice versa.

In the case of the master FMEA structure of the air filter assembly and its variant, while analyzing the
master or the variant, if you come across any risks or issues that are applicable to both, you can compare
the structures and study the similarities and differences. You can then align the master FMEA with the
variant FMEA or vice-versa, to carry forward the required issues and failure modes.
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Creating, comparing, and aligning FMEAs can help you to build a knowledge database within a company
by transferring knowledge between all FMEAs.

Create variants of a master FMEA
You can create a variants of released FMEAs whose category is set to Master.

You can specify the FMEA properties that you want to include or reset in the FMEA variant, using the
configuration file.

1. Open the master FMEA.

2. Click FMEA Variant Generation Mode.

© = Air Intake System Design FMEA V2 | &

Owmner: Engineer.Ed (ed) Date Modified: 29-Apr-2024  Type: FMEA  FMEA Category: Master FM

Select = = FMEA
ig Tree ~ V4 :_ft"' p‘ Fing I'E':I Expand G:l Agdd Y, Filkers ‘::.} \baiant. b
Mame % T e e——
*® FMEA Variant Generation Mode
b &6 Air Intake System Design FMEA V2 -

1 @i Air Intake System

b f@:} Supply Clean and comprass the ambient air

The FMEA tree structure changes to system element view.

3. Select the system elements that you want to include in the variant.

Namea % Release Stat E’:}
= % Airintake System e

¥ % Air Filber Assembly [ -

" % Intake Snorkel ﬁ

¥ ﬁ_ imtake Manifald e}

¥ ﬁ Turbocharger e

[ % Connecting Hose e

If you select a parent, the child elements are not selected automatically. However, if you select a
child the parents are automatically considered while creating the variant.
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4. (Click Generate Variant FMEA.

e

« » Air Intake System Design FMEA V2 &

Owmer: Engineer.Ed (ed) Date Modified: 29-Apr-2024  Type: FMEA  FMEA Category: Master  FMEA Type: Design
T—S Tree = . i"" et p Find Filters 3% Delete %fﬁ,;‘:"'_& ] Ei‘_"'a e
MName = Hid™ T uence F {Eﬁ

Generate FMEA Variant
v @& Airntake System .

'@!. Connecting Hose 'E;ﬁ 50
@.‘ Turbacharger 30
@b Intake Snoricel 20
k a Air Filter Assembbly 10
@ Intake Manifold 40

5. Inthe Generate FMEA Variant panel, specify the Name and Description of the FMEA variant.

6. Select the Run in Background check box to continue running the FMEA variant generation process
in the background. You will receive an alert when the FMEA variant generation process is complete.

7. Click Generate.

You receive an alert when the variant FMEA is created. When you open the object in the
notification, in the Target Object section, the logs file contains information about the status of
the FMEA variant creation (partially created, successfully created, or not created).
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-~ PROPERTIES

BMessage Subject FMEA Variant "Vanant 1 - Air Intake System Design FMEA™ was generabed
Pricity:

Event Type:

Zent Date; 29-Oct-2021

Reveiver

Miiibge Boady

Related Objects: Wariand 1 - Air intake Syetem Detign FMEA

= TARGET QBJECT

s - ST Sebect
i ¥ = o 4
CreateVariantFMEA_29-10-2021-11...
Type: Text
l&?ig Qamer: ed [ed)
Date Modifled; 25-0Oct-3021 11;11

You can view all the derived variants in the FMEA Variants tab of the master FMEA.

Sele FME 5 :
e~ 5 O s Air Intake System Design FMEA V2 &
Owner: Engineer.Ed (ed) Date Modified: 29-Apr-2024  Release Status: T
Mame = {ﬁ} = -
- :: Air Intake System Design FMEA V2 Overview History  FMEA Linkages | FMEA Variants | Attachments

v - Air Intake System 5 3 .
g’ v ¥ Latest Version of All Derived Variants

4 _f(% Supply Claan and comprass the ambient air

f@ wr

» @ ArFilter Assembly

= - Seiection Select
E DI v Mode v/ Al

Name % Version Information ~ Release Status %

33 crairintake ystem De.. 1
4 % Intake Snorkel

» % Turbocharger

Compare and align FMEA structures

After creating a variant FMEA, if you update the variant FMEA, or create a new version of the master
FMEA, you can do the following:

¢ Compare and align the variant FMEA with the master FMEA
e Compare and align the master FMEA with the variant FMEA

After comparing the differences of the FMEA structures, you can align the FMEA structures.
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Compare and align FMEA structures _

Compare and align the variant FMEA with the master FMEA
1. Open the master FMEA object.
2.  Click the FMEA Variants tab.

All the variants of the FMEA that are derived from the master FMEA are displayed in the FMEA
Variants tab.

3. Inthe Latest version of all derived variants section, select the variant that you want to compare
with the master FMEA.

4. Click Generate Difference Summary [p.

Overview  History  Formsheet  FMEA Variants Generate Difference Summary
Generate difference surmmary axt with the
« LATEST VERSION OF ALL DERIVED VARIANTS latest released varsion of the sele
o Selecion , Clear 1. Export . Gemerate
P v satecons % “-Jlj e
Name % Version Information ~ Release Status & Date Released + Master FMEA & Master FMEA Version & | Owner % {‘ﬂ
:: Var 1 Air Intake Syst... [ 1 Air Intake System Design... 1 ed (ed)

To specify if you want to generate the difference summary report asynchronously, in the message
box, click Generate in Background.

In the Alerts tab, you receive a notification when the difference summary is generated.

FMEA({T) Clear
Air Intake System Design FMEA

The difference surmmany of “Air Intake System Desi..
Sent Date: 29-Clet-2021

Reports

oy
=l
Favorines

5. Open the difference summary object.

6. In the Target Object section, open the difference summary.
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The difference summary of "Air Intake System Design FMEA" with "Var 1 Air Intake System Design

= PROPERTIES

M:ﬁagc 5u|:|_|c~:t: 1 Air Intake System :e'.'g" FRAEA" was generated.

The difference summany of “Air Intake System '}:'.lgn FMEA® wath “\Var

Pricrity:

Event Type:

Sent Date: 29-0ct-2021

Receiver: Ratnakar, Saurabh (saurabhr)
Message Body:

Related Objects: Air Intake Systern Design FMEA

w TARGET OBJECT

;t_ - o o SERCHON + Selct
5 ¥ = Liads T A

FMEA-Compare-0000002

E Cwner: ed (&d)
Date Modified: 28-Oct-202113:26

The comparison of the source and target FMEA objects is displayed.

The source FMEA is the latest released version of the FMEA that you select in the Latest version of
all derived variants table that you want to compare with the master FMEA. The target FMEA is the
master FMEA that you used as reference to create the variant.

FMEA- Compare-OUﬂDUUEIDIfference summary of source and target FMEA

Targirt FMERA Air bntaks Sy

Source FMEA: Vi 1 Alr intake e Dasign EMEA

Difference Type Name = Context % Description = D =

& Air Intake System

f[ﬂ_l} Clean and compréss the ambi..  Airintake :|, tem Des gn FREA

Structure Modified Air Intake System Design FMEA SE-REP-00000000

FUN-REP-000000001

Structure Madified

Structure Madified ' % Air Filter Aszembly Air Intake System Design FMEA SE-REP-000000002
Structure Maodified % Intake Snorkel Air Intake System Design FMEA SE-REP-000000002
Structure Modified ¥ -.v Intake Manifold Air Intake System Design FMEA SE-REP-0O0000000T

Structure Madified Air lmtake Systemn Design FMEA SE-REP-000000006

b % Connecting Hose

The difference summary is also available in the History tab.

Based on the changes in the FMEA structures listed in the difference summary, you can align the
FMEA structures as required. To know more about the types of differences listed in the difference
summary and their resolutions after alignment, see FMEA comparison difference types.
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7. To align the source FMEA with the target FMEA, in the difference summary, select the row
corresponding to the difference that you want to align with the target FMEA.

8.  Click Align gz.

To align an object that has children, make sure that you expand the structure and select the child
objects.

Note:

You cannot align target objects that are released. To align a released master FMEA with the
variant, you must first create a version of the master FMEA.

FMEA-Compare-0000002/Difference summary of source and target FMEA

Lowroe FMEA: Var 1 Al Ing m Dhesign FEA Target FMEA: Alr ingaios Sy Drasign FMEA

Bame yoimeer s o
Difference Type = Name = Context = Description 2 o = S
Structure Modified - Q Air Intake System Air Intake System Design FMEA SE-REP-DO0000001

Structure Modified » f‘t'i;) Clean and compress the ambi...  Air Intake System Design FMEA FUM-REP-000000001
Structure Modified 3 Q, Air Filter Assermblhy Air Intake System Design FMER SE-REP-000D00002
Structure Modified ¥ ev ntake Snorke! Air Intake System Design FMEA SE-REP-00000000&
Structure Modified ] % Intake Manifold [7 Air Intake System Design FMEA SE-REP-000000007
Structure Modifiad 3 *‘, Connecting Hoze Air Imtake System Design FMER SE-REP-D00000006

In the Alerts tab, you receive a notification that displays the status of the alignment.

Structure Modifed 3 t_ |ntake Snarkal

i

FMEA(T) Clear
g JFMEA Structure "Air Intake Systern Design FMEA®
Sent Date: 29-0ct-2021

You can open the log file to view details about the alignment.
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m FMEA Structure " Air Intake System Design FMEA" was aligned with Structure

0110

* PROPERTIES

Message Subject: FMEA Structure “Air Intake System Design FMEA" was aligned with Structure "Var 1 Air
Priority:

Event Type:

Sent Date: 29-0Oct-2021

Receiver:

Message Body:
Related Objects: Air Intake System Design FMEA

w TARGET OBJECT

TH 1 it v — Selection Select
] uis Y= Mode v Al

n,  AlignFMEAStructure_29-10-2021-...
Type: Text
é'ﬂg Owner: ed (ed)
Date Medified: 29-0ct-2021 11:21

Compare and align the master FMEA with the variant FMEA
1. Open the variant FMEA object.

2. Inthe Overview tab, the MASTER TEMPLATE section displays the information about the latest
version of the master FMEA that was used as reference to create the variant.

H ;T-,;.: ¥ il o ot Overview  History  Formsheet  FMEA Variants
M @ Creation Date: 28-Oct-2021
¢ Extemal Failures Engineering/Manufacturing Location: Pune

b % Air Intake System Confidentiality Level: Business Lza

+ MASTER TEMPLATE

— Sefection Seiact Export
= Mode ] = =
Mame % Version Information & | Latest Released Vers... = Latest S 1423
:: Air Intake Syvtem Degign.. 1 1 Trua 28-q
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In the Master Template table, select the master FMEA and click Generate Difference Summary
4.

Generate Difference Summary

Generate difference summary of FMEA in context with the

* MASTER TEMPLATE

- Selaeon =T o, Espon R Ganarate
¥'= Miods > Selections ¥ ) B mettgran

Mame & Version Infarmation & Latest Released Vers... & Latest & @ I {‘:ﬂ:}

:: Air Intakes System D [ | 1 1 True 28-0

¥

To specify if you want to generate the difference summary report asynchronously, in the message
box, click Generate in Background.

In the Alerts tab, you receive a notification when the difference summary is generated.

FMEA(T) Clear
Var 1 Air Intake System Design FMEA

The difference summany of “Var 1 Ar Intake Syste

Sent Date: 29-0ct-2027

[« h;lp- 1

Bl
Scheduies
Schaciuba

Tagkcs

4.  Open the difference summary object.

5. Inthe Target Object section, open the difference summary.
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The difference summary of "Var 1 Air Intake System Design FMEA" with "Air Intake System Design

+* PROPERTIES

Message Subject: The difference summarny of "Var 1 Air [ntake Systern Design FMEA™ with "Air Intake System Dessgn FMEA" was generated
Puorit:r.

Event Type:

Sent Date: 29-0ct-2021

Receiver: Ratnakar, Savrabh (saurabhs)

Message Body:

Related Objects: Var 7 Air Intake Systern Design FMEA

* TARGET OBJECT

T it o = Talecton o Salect 12, Gxport
* = Mece A 1 T

FMEA-Compare-0000001
Owner: ed (ed)
==| Date Modified: 28-Oct-2021 11:21

The comparison of the source and target FMEA objects is displayed.

The source FMEA is the master FMEA that you select in the Master Template table that you want
to compare with the variant FMEA. The target FMEA is the variant FMEA.

<= FMEA-Compare-0000001/Difference summary of source and target FMEA -
E SIEMENS
Source FMEA: Air intak A Target FMEA: Var 1 Alr Sevign FMEA o
o — SHACHoN » SelaCy 0

Eﬂ Tree ¥= Mode b | &‘ Alige
Difference Type = Hame & Context & Description & D 2 @
Structure Modified - Q& Air Intake System Var 1 Air Intake System Design FMEA SE-REP-DO0000017
Structure Modified ¥ f“lé Clean and compress the ambi..  Var 1 Air Intake System Design FMEA FUN-REP-DO000001
Structure Modifisd ] ‘e Intake Manifald Var 1 Air Intake System Design FMER SE-REP-DOD0000TE
Structure Modified » Q Connecting Hose Var 1 Air Intake System Design FMEA SE-REP-DO00000019
Structure Modified B b @ AirFilter Assembly Var 1 Al Intake System Design FMEA SE-REP-DD0000021
Structura Maodifisd ] % Intake Smars Var 1 Air Intake System Deign FMER SE-REP-DDO000022
1 1]

The difference summary is also available in the History tab.

Based on the changes in the FMEA structures listed in the difference summary, you can align the
FMEA structures as required. To know more about the difference types listed in the difference
summary and their resolutions after alignment, see FMEA comparison difference types.

6. Toalign the source FMEA with the target FMEA, in the summary report, select the row
corresponding to the difference that you want to align with the target FMEA.
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Compare and align FMEA structures _

7.  Click Align gg.

To align an object that has children, make sure that you expand the structure and select the child
objects.

25 FMEA-Compare-0000001/Difference summary of source and target FMEA

E Sownce FMEAC Alr inta Design FMEA Tanget FMEA: Var 1 A intako e Duesign FiEA
fgme gz senc 8B
Difterence Type & Mame @ Comtext & Description & D 4 @ ol
Saructure Modified - ‘.? Air Intake System War 1 Aur Intake System Dessgn FMEA SE-REP-QOO00001T
Structure Modified [ f[ﬂ_ Clean and compress the ambi..  Var 1 Air Intake System Design FMEA FUN-REP-00000001
Structure Modified ¥ e_ Intake Manifeld ‘ar 1 Air Intake System Design FMEA SE-REP-000000018
Structure Modified | * Q. Connecting Hose [5'] Var 1 Air Intake System Des:gn FMEA SE-REP-0000C0019
Srructure Modified ¥ % Air Filter Assembly Var 1 Air Intake System Dessgn FMEA SE-REP-000000021
Strueture Modified ¥ Q' Intake Snarkel Var 1 Air intake System Design FMEA SE-REP-000000022

1 ¥
Note:

You cannot align target objects that are released. To align a released master FMEA with the
variant, you must first create a version of the master FMEA.

In the Alerts tab, a notification displays the status of the alignment.

FMEA(T) Clear
Var 1 Air Intake System Design FMEA

FMEA Structure "Var 1 Air Intake Systern Design F..,

Sent Date: 29-Oct-2021

You can open the log file to view details about the alignment.
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FMEA Structure "Var 1 Air Intake System Design FMEA" was aligned with Structure "Air Intake System Design FMEA".

~ PROPERTIES

Message Subject: FMEA Structure “Var 1 Air Intake System Design FMEA” was aligned with Structure "Air Intake System Design FMEA
Prigrity:

Event Type:

Sent Date: 29-0et-2021

Recedver:

Message Body:

Related Objects: ‘ar 1 Air Intake System Design FMEA

~ TARGET OBJECT

s AlignFMEAStructure 29-10-2021-...
lL;'.E Type: Text

gl Owner ed e

—— Datc Modified: 29-Oct-2021 11:21

FMEA comparison difference types

After comparing the changes in the FMEA structures listed in the difference summary, you can align the
FMEA structures.

The following table specifies the difference types listed in the report and their resolutions after

alignment.
Difference Resolution after
type Description alignment

Structure The structure of the source FMEA is modified. Therefore, The structure of the target
modified the structure of the target FMEA is not the same as that of FMEA is updated to align
the source FMEA. the target FMEA with the

For example, if you add or remove the existing system source FMEA.

elements, functions and its related higher or lower
functions, or failures and the related causes and effects of
the source FMEA, the difference summary will show these
changes as Structure modified.

Structure The structure and properties of the source FMEA are The structure and
and modified. Therefore, the structure and properties of the properties of the selected
property target FMEA are not the same as that of the source FMEA.  objects in the target FMEA
modified . - are updated to align the
For example, if you add or remove the existing system .
4 . . target FMEA with the
elements, functions and its related higher or lower source EMEA

functions, or failures and the related causes and effects
of the source FMEA, or update the name and description
of the source FMEA, the difference summary shows these
changes as Structure and property modified.
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FMEA comparison difference types _

Difference Resolution after
type Description alignment
Property A property of the source FMEA is modified, so the The modified properties of
modified properties of the target FMEA are not the same as that of  the target FMEA are copied
the source FMEA. from the source FMEA to
. . - align the target FMEA with
For example, if you modify the name and description of the target FMEA.

the source FMEA, the difference summary shows these
changes as Property modified.

Missingin  Objects that exist in the source FMEA are missing in the The objects missing in the
Target target FMEA. target FMEA are created to

. . . align the target FMEA with
For example, if you delete objects in the target FMEA, or the source EMEA.

add new objects in the source FMEA, or while creating the
variant you do not select some objects in the source FMEA,
the difference summary shows such changes as Missing in

target.
Exist only in Objects that exist in the target FMEA are missing in the The objects that exist only
Target source FMEA. in the target FMEA are

deleted to align the target
FMEA with the source
FMEA.

For example, delete objects in the target FMEA, or add new
objects in the source FMEA, the difference summary shows
such changes as Exist only in Target.
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6. Create the cross-functional team

Specify users responsible for creating and modifying the FMEA

After you create an FMEA, you must specify the users who are responsible for creating the FMEA
structure, specifying the functions, failure causes and effects, and the initial and revised prevention and
detection actions. You also specify the stakeholders who will review and approve the FMEA.

1. Open the FMEA.
2. Inthe Overview tab, in the Cross-Functional Team section, click Add to .
3. Inthe Add panel, select the relevant group and role, select the users, and click the Add button.

After you create the cross-functional team, you can create the FMEA structure using system elements
and perform the structure analysis.
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7. Perform the structure analysis

About structure analysis of an FMEA

After you specify the scope of the FMEA and the cross-functional team, you can perform the structural
analysis of the FMEA. To do this, you identify the different components within the assembly of a
design FMEA, or the logical hierarchical steps of a process FMEA, and add them as system element
representations to the FMEA. To create the FMEA structure, you can add child system element
representations or functions under the system element as required.

Example:

FMEA Root
Node

System Element
Representation 1

» System Element
Representation 2

System Element
* Representation 3

System Element
Representation 4

System Element
* Representation 5

You can perform the structure analysis using any of the following methods:
* Create boundary diagrams for design FMEAs.
* Create the Interface matrix for design FMEAs.

* Create process flow charts for process FMEAs.

Create the structural representation of the FMEA

To perform the structural analysis of the FMEA that you are analyzing, you identify the different
components within the assembly of a design FMEA, or the logical hierarchical steps of a process FMEA,
and add them as system element representations to the FMEA.

1.  Open the FMEA.
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_ 7. Perform the structure analysis

2.

Choose More Commands ««+ > New >/ > Child.

In the Search tab, a list of the system element specifications is displayed. You can filter the list by
typing the name of the system element and select the system element.

Select a system element representation.
To include the system element, click Add.

If the required system element specification is not available, click the New tab, and specify the
name and description to create a new system element representation.

You can add child system element representation under a system element representation as
required.

While creating a new system element representation, if you retain the Create and link its master
data check box selection, the system element representation that you create specific to the FMEA is
created as a specification at the highest level in the Quality Master Data library.

After creating the FMEA structure, you can perform the function analysis where you specify the
functions of the different components in the FMEA structure and their requirements and characteristics.

Using boundary diagrams for structure analysis of design FMEAs

About boundary diagrams for design FMEAs

A boundary diagram is a graphical tool that facilitates the brainstorming and structure analysis of
the system under consideration. You can add, edit, or delete system element representations in the
boundary diagram.

You can create the following types of interface between the various system elements:

P - Indicates a physical connection between the system elements. For example, the system elements
can be welded, bolted, or clamped.

E - Indicates that energy is transferred between the system elements. For example, there is force or
heat exchanged between the system elements.

| - Indicates that information is transferred between the system elements. For example, ECU, sensors,
or signals, can be transferred between the system elements.

M - Indicates that material is exchanged between the system elements. For example, cooling fluid, or
exhaust gases, can be exchanged between the system elements.

D - Indicates that data is exchanged between the system elements. For example, data transfer
between a USB drive and a computer.

7-2



Add system element representations in the boundary diagram _

* H - Human-Machine: Indicates a human-machine interaction where data is exchanged between
humans and machines.

The systems, sub-systems, and components are represented by boxes and you can connect them using
arrows which represents their interaction. The boundary diagram helps you in performing the structure
analysis of the system and connect it using interfaces.

Overview  History  Structure Analysis Boundary Diagram  Interface Matrix =~ Risk Matrix ~ Attachments

3"@ Apply ’2_@ saue P Add ﬁ’fg) Interface ¢~ Edit g ocate

Layout Layout 4 in tree

‘ % Air Intake System

v

E
‘ % ntake Snorkel ‘ \ % Turbocharger

‘ % Connecting Hose ‘ ‘ % Intake Manifold

‘ % Air Filter Assembly

>

Add system element representations in the boundary diagram
You can add system element representations to the FMEA boundary diagram.
Procedure

1.  Select the system element representation in the FMEA tree structure and choose More Commands
«e+ > Manage 3% > Show Boundary Diagram.

2. Click the Boundary Diagram tab.
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_ 7. Perform the structure analysis

A visual representation of the FMEA structure is displayed.

3. Select a system element in the boundary diagram, on the top toolbar, click Add and choose System
Element or External System Element as relevant.

Overview History Structure Analysis Boundary Diagram

IET_—} Add ﬁ_ij nrzrface I{/‘r’ Edit

H—“ Systern Element

'H—“ External System Element

4. Inthe Create panel, do one of the following:
» Search for an existing system element.

* Click the New tab, specify the name for the system element representation, and click Create to
create it.

The system element representation is added as a child to the existing system element representation.

Specify interfaces between the system elements in the boundary diagram

After you add system element representations in the boundary diagram, you can specify the interface
types between them.

Procedure
1. Open the FMEA object.

2.  Select the root node of the FMEA in the tree structure and choose More Commands <.« > Manage
%2 > Show Boundary Diagram.

3. Inthe Boundary Diagram tab, click Interface, and select the required connection type from one of
the following:

* One Way Direct
* Two Way Direct

* One Way Indirect
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Modify the properties of system element representations or interface connections in the boundary diagram _

* Two Way Indirect
4. Select the system element representation from which you want to create the interface connection.
5. Drag to select the second system element representation that you want to connect to.
6. Click Exit Interface after you have created the required connections.
7.  To specify the interface type, click Edit to edit the boundary diagram.
8. Select the connection between the system elements and click Edit Interface /.
9. Inthe Edit Interface panel, select the required Interface Type option from the list.

You can also modify the Interface Type Value, Interface Details, Connection Type, or Interaction
Type.

10. Click Save to save your changes.

11. Click Save Edits [£) to save the changes to the boundary diagram.

Modify the properties of system element representations or interface
connections in the boundary diagram

After you add the system element representations and specify the interface relation types, you can
edit the interface connections, delete a system element representations, or modify its properties in the
boundary diagram.

You can do the following:
Edit the properties of system element representations in the boundary diagram
1.  Select the system element representation and click Edit /.
2. Modify the properties as required.
3. Click Save Edits [5).
Edit the interface type between the system element representations
1.  Select the connection between the two system element blocks and click Edit Interface /.
2. Inthe Edit Interface panel, modify the required options.

3. Click Save to save your changes.

7-5



_ 7. Perform the structure analysis

4. Click Save Edits [Z] to save the changes to the boundary diagram.
Delete a system element representation in the boundary diagram

To delete a system element representation in the boundary diagram, select it and click Delete 3¥.

Using the interface matrix to perform structure analysis of design
FMEAs

About the FMEA interface matrix

An interface matrix provides additional inputs for system or subsystem FMEAs.

In Teamcenter, depending on the scope of the FMEA, the interface matrix table shows the subsystems
and the components in the columns and rows of a table. This representation helps you to identify the
interfaces and their types that must be considered while performing the structure analysis.

You can specify the following types of interfaces between the various system elements:

* D - Data Exchange: Indicates that data is exchanged between the system elements. An example of
this is data transfer between a USB drive and a computer.

* E - Energy Transfer: Indicates that energy is transferred between the system elements. For example,
there is force or heat exchanged between the system elements.

* |- Information Transfer: Indicates that information is transferred between the system elements. For
example, ECU, sensors, or signals, can be transferred between the system elements.

* M - Material Transfer:Indicates that material is exchanged between the system elements. For
example, cooling fluid, or exhaust gases, can be exchanged between the system elements.

* P - Physical Connection: Indicates a physical connection between the system elements. For example,
the system elements can be welded, bolted, or clamped.

* H-Human-Machine: Indicates a human-machine interaction where data is exchanged between
humans and machines.

Creating an interface matrix ensures that all the types of interfaces are included in the FMEA. The
functions of the FMEA include all the identified interfaces. Each interface in the FMEA boundary diagram
and the FMEA interface matrix has a one-to-one linkage to a corresponding function in the design FMEA.

In the interface matrix, you can:

* Create or add system elements at the same hierarchical level as siblings and the subsequent level as
children.
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Add system elements in the interface matrix _

* Edit or delete the existing system elements and their properties.
* Change the order of the system elements (based on the sequence numbers.

* Add, edit, or delete the interface type between the system elements.

O (& EcNooo1sE/A:... )

Air Intake System Design FMEA V2 | &

‘Owner: Engineer,Ed (ed) Date Modified: 29-Apr-2024  Type: FMEA  FMEA Category: Master Sl Air Intake System
A Select | FMEA PO i
lE; Batree ~ | V3 Drine Qoema @ ase Variant.. Air Intake System e
x| Owner: Engineer.Ed (ed) Date Modified: 30-Apr-2024  Release Status: More...
. Name % Se {83 a
H.‘,.“E - :: Air Intake System Design FMEA V2 Overview  History  Structure Analysis  Boundary Diagram  Interface Matrix  Risk Matrix >
. e «% Ar Intake System 10 .
= & Refresh  ro Locate o = o
Assistant O intertsce P inee L L Jscreen
4 f{@ Supply Clean and compress the ambient air 10
" q,L‘J Air Intake System
Discussions f{@ CRF1 20
B 4 Air Filter Assembl; 10
Explorer i3 v
@ 4 -t; Intake Snorkel 20 &
Inbo: & 3
o 4 -% Turbocharger 30 \v"a "}Q‘\"
- &
A . G »
P 4 % Intake Manifold 40 ty‘ "\5‘
AN 4 -% Connecting Hose 50 »
Changes 2 2
b | & External Failures
£ B-@y Air Filter Assembly
Program
Deliverables @ Intake Snorkel 2 P+2 ..
& Turboch 2
Declarations @ Turbocharger 2 )
@ Intake Manifold
9 £
- .
D;;:;‘:;" :;1\ @ Connecting Hose | ‘
°
3
3
£
z
<

Add system elements in the interface matrix

You can add system element representations in the interface matrix table of the FMEA.
Procedure

1. Open the FMEA object.

2. Select the system element representation in the FMEA tree structure and choose More Commands
««+ > Manage 3% > > Show Interface Matrix.

3. Click the Interface Matrix tab.
4. Select the root node of the FMEA in the interface matrix table and click New > Child.
5. Inthe Create panel, do one of the following:

a. Click New to create and add a new system element.
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_ 7. Perform the structure analysis

b.  Search for the required system element.

6. Click Add or Create.

Specify the interface type between the system elements in the interface
matrix

After you add the system elements to the FMEA structure, in the interface matrix, you can specify the
interface type between two system elements. You can create multiple interface types between two
system elements if required.

Procedure
1. Open the FMEA object.

2.  Select the root node of the FMEA in the tree structure and choose More Commands <.« > Manage
%2 > Show Interface Matrix.

3. Inthe Interface Matrix tab, in the table, select any cell that corresponds to the intersection of the
row and column of the system element representations between which you want to specify the
interface type.

The direction of the interaction is created from the selected row to the selected column.

4. Click Create Interface &2.
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Specify the interface type between the system elements in the interface matrix _

Overview  History  Structure Analysis

Boundary Diagram  Interface Matrix  Risk Matrix

Create ¢, Refresh r~ Locate . r - Ful
d’_(% Interface “/ Interface 2 in tree |._D Copy L - Screen
Air Intake System
=
R 5 &
& @ & & 'S
?EJ -\0\ ‘Q' ’b(\ 5 (\Cy
g § n < &
A g o~ LS &
A B el B &
v & A3 & &
| - [ | <] g -
4
2 2
P Air Filter Assembly
@ Intake Snorkel 2 P+2 ..
@ Turbocharger 2 P+2 ..
@ Intake Manifold
[

# Connecting Hose

Air Intake System

In the Create Interface panel, verify the primary and secondary system elements.

5. In Properties, select the required function type from the Interface Type list.

* D - Data Exchange

E - Energy Transfer

* |- Information Transfer
* M - Material Exchange
* P - Physical Connection
* H-Human-Machine

6. Specify the Interface Type Value.

You can specify the following values:

Failure Mode and Effects Analysis, Teamcenter 2412
© 2025 Siemens
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_ 7. Perform the structure analysis

* +2 - Indicates that the interaction is necessary for the functionality.
* +1 - Indicates that the interaction is beneficial, but not necessary for the functionality.
* 0 - Indicates that the interaction does not affect the functionality.

* -1 -Indicates that the interaction causes negative effects on the functionality but odes not
prevent it

» -2 -Indicates that the interaction must be prevented to achieve the required functionality.
7. Inthe Interface Details box, enter any additional information that you want to specify.
8. Specify the Connection Type as Direct or Indirect.
9. Specify the Interaction Direction as Two Way or One Way.

For one way interactions, the direction of the interaction is created from the selected row to the
selected column.

10. Click Create.

Modify the system element connections and interface types in the interface
matrix

You can edit the system element connections and interface types in the interface matrix.
Procedure
1. Open the FMEA object.

2. Select the system element representation in the FMEA tree structure and More Commands «e« >
Manage 3% > Show Interface Matrix.

3. Inthe Interface Matrix tab, in the interface matrix table, select a cell that corresponds to the
primary system element whose interface you want to edit.
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Delete system element representations in the interface matrix _

Air Intake System

0
& > 5
a?ist’@ 0‘\& ‘%z’\ (\{\o . (f\
& oy o &° &
& e o & &
= & i & o
& ) | L ] &
»
2 2
p-@ Air Filter Assembly
@ Intake Snorkel 2 PﬁZ
R
@, Turbocharger 2 P+2..
@ Intake Manifold
# Connecting Hose

Air Intake System

A table that lists the system element is displayed.

4. Select the system element row in the table, and click Edit Interface /.

Edit < Delete
jlr:erf e j,(Deete IE"'\".ﬁ\l

b

Primary System Element Secondary System Element Interface Type

Edit Interface
Intake Snorkel Turbocharger P

Edit properties of selected interface
Intake Snorkel Turbocharger M +1

5. In the Edit Interface panel, modify the properties as required.
6. Click Save.
Delete system element representations in the interface matrix

You can delete the system element representations in the interface matrix. You can also delete multiple
interface types specified between the system elements.

Procedure
1. Open the FMEA and click the Interface Matrix tab.

2. Select the row corresponding to the primary system element in the interface matrix table and click
Delete $<.




_ 7. Perform the structure analysis

The interface matrix table is updated accordingly.

Using process flow charts to perform structure analysis of process
FMEAs

Using process flow charts to analyze processes

A process flow chart shows a graphical representation of the process flow and the various stages that
the product goes through in the process. You can view or update process flow charts to identify and
analyze processes.

You can:

* Create and add new system element representations to the process flow chart.

* Edit or delete existing system element representations.

* Modify the order of the processes as required.

The following graphic shows an example of the process flow chart for a process FMEA.

Select . §
taTree v e 5O Find & Edit ees Body Frame P
- N {% Owner: ed (ed) Date Modified: 03-Nov-2023  Release Status: More...
ame w
¥ @& Smart Phone X- 904 Process FMEA Overview  History  Structure Analysis  Process Flow Chart  Risk Matrix
= % Body Frame
.. Apply Save T r A Full

! Layout R Layout @ A L Screen

- % Injection moulding
f(@ Injection moulding of frame |E| Start
@ Deburring




View the process flow chart for process FMEAs _

View the process flow chart for process FMEAs

You can view process flow charts that show a graphical representation of the process flow and the
various stages that the product goes through in the process.

Procedure
1. Open the process FMEA object.
2. Select the system element representation in the FMEA tree structure.
3. Choose More Commands <+« > Manage > Show Process Flow Chart ©.
The Process Flow Chart tab displays the graphical representation of all the processes in the FMEA.

To hide the process flow chart, choose More Commands ««« > Manage > Hide Process Flow Chart
B.

Edit the process flow chart

You can edit the layout of the process flow chart to modify the name and sequence of the system
element representations. You can also edit or delete objects in the process flow chart.

Procedure
1. Open the process FMEA object.

2. Select the system element representation in the FMEA tree structure and click the Process Flow
Chart tab.

3. Modify the objects in the process flow chart in one of the following ways:
* Edit the system element representation in the process flow chart

a. Select the system element representation and click Edit /.
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-
Edit the properties shown of process o dhart. To edif select

& b aeed Clici Can Dhis propesety 10 ecii

sture Analysis  Process Flow Chart
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b.  Update the name and sequence of the system element representation.

Owerview  History  Formsheet  Structure Analysis  Process Flow Chart
APy St e Carcel S Delete

:"E}Law'- Eckty #2 gy

| F | Start
| | End
L)

Injection Moulding ]u

il Body frame of the Smart Phone
Lequence :

\% Storage &

& ¢ Operation

l ................. .
Deburring I

Ve 3 Characteristic - Body.
o T ]

% Oiperation
";H Test Characteristic

c.  Follow similar steps to edit the sequence value of other system element representations
that you want to reorder.

d. Click Save Edits [£) to save your changes.
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Owerview  History  Formsheet  Structure Analysis  Process Flaw Chart

% s

(] sor = o
| !

Injection Moulding
Lequence 10

Ll

Charactenistic - Body..,
Sequence; &0

r$ Storage
"i | Test Characteristic
Deburring ]

- Body frame of the 5.

Seqguence: 30
# Operation
ﬂ Operation

* Delete the system element representations in the process flow chart

In the Process Flow Chart tab, select the system element representation and click Delete to
remove it from the process flow chart.

Failure Mode and Effects Analysis, Teamcenter 2412
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Overview ~H e e sesman Structure Analysis  Process Flow Chart

B PR e | Oelete

wrpmat

[ s W]
! r

Injection Moulding i

Sequence: M Characteristic - Body...
Sequence: 40

@ Storage
e ﬁE Test Characteristic
Deburring I

Sequence: 20 E-Dd]" frame of the 5...
Sequende; 30

ﬂ Operation
ﬁ Operation

* Edit the properties of the system element representation in the Information panel

a. Inthe Process Flow Chart tab, select the system element representation, and click
Information.
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ore... T ¢ B|O|%

; } Air filter Infarmation
Cramer: ed (ad) Date Modified: 10-Mov-2023  Release Status: Type: System Elemer
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b. Inthe Information panel, click Edit.

c.  Select the required System Element Sub-Type.

Note:

You can also edit other system element representation properties displayed in the
Information panel.

d. Click Save.

Create and add new system element representations to the process flow
chart

You can create and add new system element representations in an existing process flow chart. When
you create system element representations in the process flow chart, they are displayed in the FMEA tree
structure and the process flow chart.

Procedure

1. Inthe Process Flow Chart tab, click Add .
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2. Inthe Add panel, specify the Name and Description.

3. Click Add.

Note:

The default type of the system element representation that you create in the Process Flow
Chart tab is set to Process. You can edit the type and change it to Design. After modifying,
the design type of system element representation is removed from the process flow chart.
However, it is retained in the FMEA tree structure.

7-18 Failure Mode and Effects Analysis, Teamcenter 2412
© 2025 Siemens



8. Perform the function analysis

Specify the functions of the system elements in the FMEA structure

During function analysis, you define the functions of each component of the assembly or process

for which the FMEA is performed. You also add the requirements and characteristics of the function
representations. You can perform the function analysis after you perform the structure analysis of the
FMEA.

To perform a function analysis:

1. Add a function representation to a system element representation

N

Add higher-level or lower-level functions to the function representation
3. Add requirements to the function representation

4. Add characteristics to the function representation

Add a function representation to a system element representation

A system element representation such as Air Filter Element can have function representations such as
Filter the air.

1.  Select a system element representation.
2.  Choose More Commands <+« > New -2 > Function.
3. Inthe Create panel, do one of the following:

* In the Search tab, under FUNCTIONS, type the name, or use a wild card character such as an
asterisk (*), to search for and add the required function representation to the system element.

* Click the New tab to create a new function representation and add it to the system element.

While creating a new function representation, if you retain the Create and link its master data
check box selection, the function representation that you create specific to the FMEA is created
as a specification at the highest level in the Quality Master Data library.

Add higher-level or lower-level functions to the function representation
1. Open the FMEA.

2. Select a function that is added under the system element representation.
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_ 8. Perform the function analysis

3. Click the Function Analysis tab that is displayed to open it.
The net view of the FMEA is displayed.

4. To add a function at the level immediately above the selected function, choose More Commands
««s > New -2 > Next Higher Level Function.

You can also drag a function from the FMEA tree structure and drop it in the net view display.
5. Inthe Add panel, do one of the following:
* Click New to create a new function and add it to the FMEA.

* Click Search to search for an existing function. You can select a function within the current
FMEA.

» Specify if you want to add functions from the current FMEA, or select the Function Library
check box to search for a function from the library.

In the FMEA tree structure, you can view the external (local) functions of an FMEA under
External Functions.

T_UD Tree with » Select
5 Summary Al

-

Mame =

~ | fig| External Functions

Iy . -
j(@ Clean and compress the ambient air

- % Air Intake System
frn o : : .
jl{:@g Filter the air to provide clean air
» @ AirFilter Body
6. After you select the required function from the search results, or create a new one, click Add.
The function is added to the FMEA.

7. Toadd a function at the level immediately below the selected function, choose More Commands
««« New -2 > Next Lower Level Function, and perform steps 5 and 6.

Add requirements to the function representation

1. Open the function representation from the FMEA object in the tree view.
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This is the object you created when you added a function representation to a system element
representation.

2. To add the requirement, click the Requirements tab and click Add to . In the Add panel, select
the requirement from the New or Palette tab or search for it in the Search tab and click Add.

Note:

You can also copy an object and add it as a requirement to the function representation.

3. (Optional) To remove the object, select it and click Remove (.
Add characteristics to the function representation

For each manufacturing operation, you can optionally add the characteristics that define what is being
measured on the shop floor. For this, you add an Inspection Definition that contains the required Quality
Characteristic.

You can also add characteristics such as diameter, length, surface roughness, and so on, which are
important for the production of prototypes and pre-series parts. These characteristics are required for
prototype control plans and pre-series control plans.

1. Open the function representation from the FMEA object in the tree view.

This is the object you created when you added a function representation to a system element
representation.

2. To add the characteristic, click the Characteristics tab and under Inspection Definition, click Add

)

Note:

You can also copy an inspection definition and add it as a characteristic to the function
representation.

3. Inthe Add Inspection Definition panel, under Properties, specify the Name and Description .
4. In the Add Characteristic section, click Add To .
5. To add a Quality Characteristic including its criteria, do the following:

a. From the Characteristic Group Type list displayed, select the required Characteristic Group.

b. Select the required Quality Characteristic from the available Quality Characteristics of the
group, and click Attach.
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_ 8. Perform the function analysis

c.  (Optional) To replace the Quality Characteristic that you have added, click Replace .~ in the
Add Characteristic section.

6. Click Add.
7.  (Optional) To remove the object, select it and click Remove =

The FMEA object to which the function is attached is displayed in the Context field in the Overview tab.
You can return to the FMEA object and add more functions to the structure if required.

After adding the required functions, requirements, and characteristics, and ensuring that they are
appropriately allocated to the system elements, you can perform a failure analysis of the FMEA.
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Specify the potential failure modes of the FMEA structure

To perform the failure analysis of an FMEA, you add the potential failure modes of the FMEA structure
and specify the failure effects and failure causes. In addition, you can also assign a severity value to the
failure effects.

To perform a failure analysis:

1. Add a failure representation to the function representation

2. Associate a failure effect and specify the severity

3. Associate a failure cause

Add a failure representation to the function representation

1.  Openan FMEA.

2. Select a function representation and choose More Commands <<+ > New =< Failure.

3. Inthe Create panel, in the Search tab, a list of the failure representations is displayed. You can
filter the list by typing the name of the failure representation and select the failure representation.

OR

If the required failure representation is not available, click the New tab, and specify the name and
description to create a new failure representation.

While creating a new failure representation, if you retain the Create and link its master data
check box selection, the failure representation that you create specific to the FMEA is created as a
specification at the highest level in the Quality Master Data library.

You can select multiple failure representations.
4. Toinclude the failure representation, click Create.
Associate a failure effect and specify the severity
1. Open the failure representation and click the Failure Analysis tab.

The net view of the FMEA is displayed.
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_ 9. Perform the failure analysis

2.

To add a failure effect, choose More Commands <<+ > New =< > Failure Effect.

In the Add panel, specify if you want to add failure effects from within the FMEA structure, or select
the Failure Library check box to search for and add failure effects from the quality master data.

In the FMEA tree structure, you can view the external (local) failures of an FMEA under External
Failures.

II'_UD Tree with » Select
al | - W
Summary Al
Mame =

= Ewternal Failures

= Engine not starting

- @ Air Intake System

i . -
o jl':@;l Clean and compress the ambient air
E@ Dirty air to engine

E@ Mo Ajr to Engine

b %, Air Filter Assembly

Do one of the following:

* Click New to create a new failure effect and add it to the FMEA.

* Click Search to search for an existing failure effect.

After you select the required failure effect from the search results, or create a new one, click Add.
If you add a failure effect specification, the corresponding representation object is also added.

You can also drag a failure effect from the FMEA tree structure to the function in the net view
display.

To specify the severity of the failure effect, do the following:
a. Select the failure representation from the FMEA structure and switch to the Table view.

b. In the Failure Effect table, in the Severity column, double-click the required cell and select a
value from the list.
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Associate a failure cause
1. Open the failure representation and click the Failure Analysis tab.
2. Toadd a failure cause, choose More Commands ««« > New - < > Failure Cause.

3. Inthe Add panel, specify if you want to add failure causes from within the FMEA structure, or
select the Failure Library check box to search for and add a failure causes from the quality master
data.

In the FMEA tree structure, you can view the external (local) failures of an FMEA under External
Failures.

Ea Tree with Select
"D Surmmary 4 All

Mame +=

» External Failures

a

E:%\ Engine not starting

- %5 Air Intake System
frov - : .
- JI':@ Clean and compress the ambient air
é@\ Dirty air to engine

r

é@\ Mo Air to Engine

b @ Air Filter Assembly

4. Do one of the following:
* Click New to create a new failure cause and add it to the FMEA.
* Click Search to search for an existing failure cause.

5. After you select the required failure cause from the search results, or create a new one, click Add.
If you add a failure cause specification, the corresponding representation object is also added.

You can also drag a failure cause from the FMEA tree structure and add it to the function in the net
view display.

After you perform a failure analysis, you can perform a risk analysis for the failure cause.
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Classify failures in an FMEA

You can classify failures in an FMEA to categorize them according to their causes, effects, or detectability
by specifying special characteristics for the failure. This can help you identify if a particular failure is
critical or minor, or whether the root cause of the failure is a functional, safety, or any other compliance
issue.

Procedure
1. Open the FMEA and navigate to the failure that you want to classify.
2. To classify the failure, do one of the following:
* Specify the classification type in the Classification column in the Tree view:
a. Inthe Tree view, select the failure in the FMEA structure.

b.  Scroll horizontally to navigate to the Classification column and double-click the cell that
corresponds to the failure that you want to classify.

c.  Select the required option.
d. Click outside the cell to save your changes.

* Specify the classification type in the Formsheet view:

* Specify the classification type in the Classification column in the Tree view:
a. Inthe Formsheet view, navigate to the failure that you want to classify.

b. Inthe Special Characteristics column, double-click the cell that corresponds to the failure
that you want to classify.

c.  Select the required option.
d. Click outside the cell to save your changes.

The classification category of the failure along with its icon is displayed in the in the Classification
column in the tree view, the Special Characteristics column in the formsheet view, and on the tile in
the Failure Analysis tab.

Edit the severity values

The default value of the severity for all failure causes and failure effects that you create is set to 10.
Depending on the intensity of the severity, you can edit the default severity value. You can edit the
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severity of failure representation, failure cause, or failure effect in the Overview tab or the failure
analysis net view and table view.

The following procedure shows how to edit the severity value in the net view.
Procedure

1. Open the FMEA object and navigate to the failure representation.

2.  Click the Failure Analysis tab.

3. Select the failure representation, failure cause, or failure effect with the severity value you want to
modify.

4. Click Edit Severity /.

You can also right-click the tile and choose Edit Severity, or choose More Commands «.« > Edit ./
> Edit Severity.

5. In Edit Severity, select a value from the list and click Save.

6. Click Save Edits [Z) to save your changes.

Note:

* The cascading severity behavior is applicable when you add or remove a failure cause or
effect.

* For relatively smaller failure data the severity value is updated synchronously. If the data is
large, the operation is asynchronous, and you receive an alert when it is completed. The
AP or RPN values are not updated immediately for an asynchronous operation.
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10. Perform the risk analysis

Specify the current prevention and detection actions to mitigate
the failure modes

To perform a risk analysis, you associate the current prevention and detection actions to a failure
cause. You can use template actions to create these prevention and detection actions. You specify the
occurrence and detection values for the prevention and detection actions, respectively. These values
can be from 1 to 10. Based on the values you specify and the design FMEA (D-FMEA) or process FMEA
(P-FMEA) guideline objects, the system determines the initial priority value, such as low, medium, or
high.

1.  Openan FMEA.
2. Select a failure representation associated with a function within the FMEA structure.

3. Click the Risk Analysis and Optimization tab and select a failure cause from the Failure Cause
Actions table.

You can create prevention and detection actions for a failure cause.

You can create preventive action and detection action if your administrator has enabled the editing
of these.

4. To add prevention actions linked to a failure cause and specify an occurrence value, do the
following:

a. Inthe Failure Cause Actions table, under the failure cause, click Add &) and select
Prevention Action or Prevention Action From Template.

b. Inthe Add Quality Action panel, specify the required parameters.

If you select Prevention Action from Template, in the Add Quality Action from Template
panel, select the required template from the list of existing templates and click Select.

c. Click Add to create the quality action.

The system automatically creates the Initial State group, if it is not already created, and adds
the quality action to it.

d. To specify an occurrence value, in the Failure Cause Actions table, select the action group, or
expand the action group to select an action, double-click the required cell in the Occurrence
column, and select a value from the list.

5. To add detection actions linked to a failure cause and specify a detection value, do the following:

10-1



_ 10. Perform the risk analysis

a. Inthe Failure Cause Actions table, click Add P > Detection Action or Detection Action
From Template.

b. Inthe Add Quality Action panel, specify the required parameters.

If you select Detection Action from Template, in the Add Quality Action from Template
panel, select the required template from the list of existing templates and click Select.

c. Click Add.

The system automatically creates the Initial State group, if it is not already created, and adds
the action to it.

d. To specify detection value, in the Failure Cause Actions table, select the action group, or
expand the action group to select an action, double-click the required cell in the Detection
column, and select a value from the list.

Note:

Your administrator can modify the preference value so that you can edit the occurrence and
detection values for the actions in an action group.

After performing the risk analysis, you can optimize the risks by prioritizing the recommended
actions.

Add initial state prevention or detection actions for a failure

You can create prevention or detection actions for failures in the FMEA tree even if they are not linked to
a failure cause.

Specify initial state prevention actions for a failures

1.

Open the FMEA and click the Risk Analysis and Optimization tab.

In the Failure Actions table, click Add & > Prevention Action or Prevention Action from
Template.

In the Add Quality Action panel, specify the required parameters.

If you select Prevention Action from Template, in the Add Quality Action from Template panel,
select the required template from the list of existing templates and click Select.

Click Add.

The system automatically creates the Initial State group, if it is not already created, and adds the
quality action to it.
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5. To specify an occurrence value, in the Failure Actions table, select the action group, or expand
the action group to select an action, double-click the required cell in the Occurrence column, and
select a value from the list.

Specify initial state detection actions for a failure

1. Open the FMEA and click the Risk Analysis and Optimization tab.

2. Inthe Failure Actions table, click Add &P > Initial Action Group.

3. Select Initial State and click Add > Detection Action or Detection Action from Template.
4. Inthe Add Quality Action panel, specify the required parameters.

If you select Detection Action from Template, in the Add Quality Action from Template panel,
select the required template from the list of existing templates and click Select.

5. Click Add.

The system automatically creates the Initial State group, if it is not already created, and adds the
quality action to it.

6. To specify detection value, in the Failure Actions table, select the action group, or expand the
action group to select an action, double-click the required cell in the Detection column, and select
a value from the list.

Assign users responsible for the prevention or detection actions

If you have not specified the users who are responsible for performing the prevention and detection
actions, or if you want to specify additional users, or the due date for the actions, you can do the
following:

1. Open the FMEA and click the Risk Analysis and Optimization tab.

2. Select the quality action in the Failure Actions or Failure Cause Actions table.
3. Choose More Commands ««« > Manage 3% > Assign Responsible User.

4. Inthe Assign Responsible User panel, select the required users and click Assign.

5. To specify the due date, double-click the respective cell in the Due Date column, and select the due
date as required.
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Visualize the identified risks in a risk matrix

The risk matrix displays a color-coded grid of the severity, occurrence, and detection values associated
with the risks. You can use the risk matrix as a reference to prioritize the quality actions for risk
mitigation.

Procedure
1. Open the FMEA and select the system element representation.
2. Click the Risk Matrix tab.

A default grid view of the severity and occurrence values of the failure causes associated with the
risks is displayed.

Administrators can modify the risk priority value in the risk matrix and override the calculated
values if required.

Risk Matrix

Severity vs.
Drcurrence

Severity vs. Occurrence

High
Medium

Low

o000

Occurrence

Undefined

Severity

3. You can do the following:

* To view the grid view of the severity and detection values, on the top toolbar, click Severity vs
Occurrence and from the list select Severity vs Detection.
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f;;n Severity ve.
% Occumrence
-

IoH -
i Severity vs. Occurrence

(3D Severity vs. Detection

J:)% Detection vs, Occurrence

B Risk Matrix Results

* To view the grid view of the detection and occurrence values, on the top toolbar, click Severity
vs Occurrence and from the list select Detection vs Occurrence.

i Severity vs.
% Cccumrence
-

IoH -
i Severity vs. Occurrence

L‘:;";. Severity vs. Detection

H‘] Detection ws. Occurrence

B Risk Matrix Results

» To view the failure causes and action groups associated with a risk, click the number in the cell.
The Failure Cause and Action Group section displays all the failures.
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Severity vs. Detection

Detection

¥ Failure Cause and Action group
Name ¥ Severity =~ Action ¥ Occurrence ¥
‘é-» Ajr Filter Element torn g Initial State 3
& loosening of air filter bolts k] Initial State 4
& ‘Water in Air Filter Element & Initial State 4

* To view all the actions associated with a failure, in the Failure Cause and Action Group section,
select a failure.

The Actions section displays all the quality actions, their type, and their status.
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Prioritize risks by viewing the consolidated risk matrix results _

Severity vs. Detection

=
=
o
]
o
=1
Severity
¥ Failure Cause and Action group
Name % | Severity = Action ¥ Occurrence ¥
| &l Air Filter Element tor N @J 8 Initial State 3
& loosening of air filter bolts Air Filter Element torn Initial State 4
2
& R .
oty Water in Air Filter Element ] Initial State 4
¥ Actions
Name % Sequence + Quality Action Subtype ¥ | Actionltem ID % | Quality Action St... ¥| Release Sta.. ¥ Comments ¥ Description ¥
é Structural Analysis of Filter Element| 10 Prevention Action QA00000000029 Draft
% Filter Element rig testing 20 Detection Action QA00000000028 Draft

Prioritize risks by viewing the consolidated risk matrix results

The risk matrix results display the priority of the severity, occurrence, and detection values associated
with the risks in a consolidated tabular format.

Procedure
1. Open the FMEA and select the system element representation.
2. Click the Risk Matrix tab.

A default grid view of the severity and occurrence values of the failure causes associated with the
risks is displayed.

E

3. To view the consolidated risk matrix results, in the Risk Matrix tab, click Risk Matrix Results .
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» Select

'Eg Tree = ./ o

) Add

p Find @ Expand ? Filters e

Name & | Hide £

Air Intake System Ma
Owner: ed (ed) Date Modified:

- :: Air Intake System Design FMEA
- % Air Intake System
4 f(@ Supply Clean and compress the ambient air
- % Air Filter Assembly

f(@ Filter the air to provide clean air
» % i Risk Matrix Results

3 4 Prioritization indicator which is formed from the risk matrix
combinations (5x0, SxD, DxQ) of an FMEA.

e 3

e

Overview History  Risk Matrix

son Severity vs.
L
Ocourrence
-

i"-".;;-’ Sewverity vs. Occurrence
%0 Severity vs. Detection
p% Detection vs. Occurrence

B Risk Matrix Results

Administrators can modify the appearance of the risk matrix results associated to a guideline object

by changing the colors associated with the risk priority value.
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11. Optimize the identified risks

Optimize risks by identifying recommended actions

After analyzing the risks, you must optimize them by identifying some recommended actions. To do

so, you can add prevention actions and detection actions. You can use template actions to create these
prevention and detection actions. For each of these actions, you can specify a due date, occurrence, and
detection values, and assign a responsible user for the action. The final priority is calculated based on the
occurrence and detection values you have specified.

The responsible user can then mark the activity as complete and the system automatically assigns a
completion date.

1. Open an FMEA object.
2. Select a failure representation from the FMEA structure.

3. Click the Risk Analysis and Optimization tab and from the Failure Cause Actions table, select a
failure cause.

You can add multiple prevention actions and detection actions to a failure cause.
Add a revision state prevention action linked to a failure cause
1. Open an FMEA object.

2.  Click the Risk Analysis and Optimization tab and from the Failure Cause Actions table, select a
failure cause.

3. Inthe Failure Cause Actions table, click Add &P, and select Prevention Action or Prevention
Action from Template.

4. In the Add Quality Action panel, specify the required parameters.

If you select Prevention Action from Template, in the Add Quality Action from Template panel,
select the required template from the list of existing templates and click Select.

5. Click Add to create the quality action.

The system automatically creates the Revision State group, if it is not already created, and adds the
quality action to it.

6. To specify a detection value, in the Failure Cause Actions table, select the action group, or expand
the action group to select an action, double-click the required cell in the Detection column, and
select a value from the list.
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Add a revision state detection action linked to a failure cause

Open an FMEA object.

Click the Risk Analysis and Optimization tab and from the Failure Cause Actions table, select a
failure cause.

In the Failure Cause Actions table, click Add P, and select Detection Action or Detection Action
from Template.

In the Add Quality Action panel, specify the required parameters.

If you select Detection Action from Template, in the Add Quality Action from Template panel,
select the required template from the list of existing templates and click Select.

Click Add to create the quality action.

The system automatically creates the Revision State group, if it is not already created, and adds the
quality action to it.

To specify a detection value, in the Failure Cause Actions table, select the action group, or expand
the action group to select an action, double-click the required cell in the Detection column, and
select a value from the list.

Add revision state prevention or detection actions for a failure

Add a revision state prevention action for a failure

1.

Open the FMEA and click the Risk Analysis and Optimization tab.

In the Failure Actions table, click Add & > Prevention Action or Prevention Action from
Template.

In the Add Quality Action panel, specify the required parameters.

If you select Prevention Action from Template, in the Add Quality Action from Template panel,
select the required template from the list of existing templates and click Select.

Click Add.

The system automatically creates the Revision State group, if it is not already created, and adds the
quality action to it.

To specify an occurrence value, in the Failure Actions table, select the action group, or expand
the action group to select an action, double-click the required cell in the Occurrence column, and
select a value from the list.
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Add a revision state detection action for a failure

1. Open the FMEA and click the Risk Analysis and Optimization tab.

2. Inthe Failure Actions table, click Add & > Detection Action or Detection Action from Template.
3. Inthe Add Quality Action panel, specify the required parameters.

If you select Detection Action from Template, in the Add Quality Action from Template panel,
select the required template from the list of existing templates and click Select.

4.  Click Add.

The system automatically creates the Revision State group, if it is not already created, and adds the
quality action to it.

5. To specify a detection value, in the Failure Actions table, select the action group, or expand the
action group to select an action, double-click the required cell in the Detection column, and select
a value from the list.

Assign users responsible for the prevention or detection actions

If you have not specified the users who are responsible for performing the prevention and detection
actions, or if you want to specify additional users, or the due date for the actions, you can do the
following:

1. Open the FMEA and click the Risk Analysis and Optimization tab.

2. Select the quality action in the Failure Actions or Failure Cause Actions table.
3. Choose More Commands <+« > Manage 3% > Assign Responsible User.

4. Inthe Assign Responsible User panel, select the required users and click Assign.

5. To specify the due date, double-click the respective cell in the Due Date column, and select the due
date as required.

Complete the identified risk mitigation actions

The FMEA engineer adds prevention action and detection actions to optimize risks. For each of the
prevention and detection actions, the FMEA engineer specifies the due date, occurrence and detection
values, and assigns a responsible user for the action.

The responsible user completes the identified risk mitigation actions and the system automatically
assigns the completion date.
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Enter the search criteria in the global search, and click O.

—_—

2. In Filters, from Type, select Quality Action.

3. (Optional) In Filters, from Responsible User, select a user.

4. In Search Filters, select the prevention action or detection action and click Open [ .
5. Click Activate and type a comment.

6. Click Complete to finish this activity.




12. Submit the FMEA for review

Initiate the review process of the FMEA structure

After optimizing the risks and identifying recommended actions, the FMEA is submitted for review using
the Release FMEA Structure workflow. To do this:

1. Open the FMEA.
Make sure that you have not selected any row in the FMEA tree structure.
2. Choose More Commands <<+ > Manage %% > Submit to Workflow.
3. In the Submit to Workflow panel, from the Template list, select Release FMEA Structure.

4.  Click Submit.

A notification verifying that the selected FMEA was submitted to the workflow is displayed.
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13. Review and approve the FMEA

Releasing an FMEA using a workflow

Once the FMEA is submitted to the Release FMEA Structure workflow, you receive an email notification
in the inbox that the FMEA is released and the status of the FMEA in the Overview tab is automatically
set to TCM Released.

The workflows for releasing the FMEA can be created based on your requirements, and you can specify if
you want to route it to users, such as quality managers, for approval.

When you release the FMEA:
* For actions in the FMEA, the released column displays the TCM Released status for released actions.

* If the FMEA is already released and it is submitted to the workflow, then it's release status remains the
same. However, any of the unreleased linked objects such as the system elements, functions, failures,
actions, inspection definitions, requirements or guideline objects are released.

After the FMEA is released, you can create a new version of this released FMEA and use it as a
reference to create and analyze another FMEA with a similar structure.
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14. Reuse FMEA objects

Reusing FMEA objects

You can copy system elements, functions, failures, or actions and paste them as new objects in the same
FMEA structure, or in another FMEA structure.

When you paste the FMEA object as a new object, a copy of the source FMEA object is created in

the destination where you paste it. You can modify the properties of the new object as required. The
newly created objects are independent of the source object. Any changes to the properties, relations, or
interfaces of the source object are not propagated to the properties, relations, or interfaces of the new
object, even if they are within the boundary or hierarchy of the source object. The IDs of the copied and
pasted objects are different.

If you are copy-pasting large FMEA objects, you can select the Run in Background option to specify if
you want to run the operation asynchronously. You will receive an alert when the copy-paste operation
is complete.

During copy-paste, the initial state or revision state quality action groups, and the actions within the
groups are copy-pasted independently. During the paste operation, the occurrence and detection values,
or RPN values of the source quality action are not carried over, irrespective of whether the automatic
carry over of occurrence and detection values from the initial state actions to the revision state actions

is enabled by your administrator. The occurrence and detection values of the pasted actions are reset to
10, which is the default value. You can update these values after the paste operation is complete. This
ensures that the risk estimation of the FMEA is not affected by the occurrence and detection values, or
the RPN values of the source object.

Copy and paste FMEA objects

You can copy system elements, functions, failures, or actions, and paste them as new objects in the
same FMEA structure, or in another FMEA structure.

Procedure
1. To copy the FMEA object to the clipboard, do any of the following:

* In the tree view, formsheet view, or net view, right-click the FMEA object that you want to copy
and choose Copy [[.

* In the tree view, choose More Commands <+« > Copy [.

2. Navigate to the location where you want to paste the copied FMEA object, right-click the
destination object and choose Paste As [Ty > New Object.

In the tree view, you can also choose More Commands <+« > Paste As [Ty > New Object.
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When you paste the FMEA object as a new object, a copy of the source FMEA object is created in
the destination where you paste it. You can modify the properties of the new object as required.
The newly created objects are independent of the source object. Any changes to the properties,
relations, or interfaces of the source object are not propagated to the properties, relations, or
interfaces of the new object, even if they are within the boundary or hierarchy of the source object.
The IDs of the copied and pasted objects are different.

(Optional) As the time taken to complete the copy-paste operation is based on the sub-structure of
the copied object, for large FMEA objects, select the Run in Background check box to specify if you
want to run the operation asynchronously.

You will receive an alert when the copy-paste operation is complete.
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15. Create a version of an FMEA

Create a new version of a released FMEA structure

—_—

Open the latest released FMEA structure.

Choose More Commands ««s > New >\ > Version FMEA.

Note:

This command is available only when you use the Release FMEA Structure workflow to
release the FMEA structure.

In the message box that appears, click OK.
A validation message appears when the new version of the FMEA structure is created.

Click the History tab to view the new version of the FMEA structure.

All the associated system element, function, and failure representations are also changed to the
next version.

A copy of the objects, which is equivalent to the output of a Save As operation, is created for all
the actions from the previous version of FMEA in the new version of FMEA with the same status
as earlier.

If the previous FMEA is generated from an item structure then the new version of the FMEA is
also linked to the source structure and can be aligned.

Inspection Definitions & Requirements are now also linked to the new version of function.

All system element, function, and failure representations are versioned even if they are not in
released state.
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16. Visualize the FMEA structure

Visualize the hierarchy of the FMEA in a net view

What are FMEA net views?

Net views help you visualize the hierarchy of the system element, function, and failure representations
in the FMEA structure. It is the default view when you perform the structure analysis, function analysis,
or failure analysis of the FMEA structure. Net views help you detect the dependencies between failures,
function elements, and system elements. The visual format helps define the causes and effects within an
FMEA structure.

You can apply Left-to-Right or Fixed layout.

The following graphic shows the Left-to-Right layout of the net view in the Structure Analysis tab.

BgTree v /3% Oring D Edt e %Air Filter Assembly L Edit oo || D]
B

N . Owner: Date Modified: Release Status: Type: System Element Representation
ame

e :: Air Intake System Design FMEA Overview  History  Structure Analysis  Risk Matrix ~ Attachments  Audit Logs

- @ Air Intake System
B B O X 2 ¢ O

I

kD@ B
4 f(@ Supply Clean and compress the ambient
| Left-to-Right
v @ AirFilter Assembly
) Fixed
j‘(@ Filter the air to provide clean air

» @ AirFilter Body

» % Air Filter Element

* @ Boitmexs0
* @ Intoke Snorkel
»
@ Turbocharger @y AirFier bocy ]

» @ Inteke Manifold
4 @ Connecting Hose [Q Air Intake System HQ Air Filter Assembly L Q Air Filter Element ~--J

v [ &] External Failures

@ Bolt M8X30 e ]
3

Working with FMEAs in the net view

Net views display the hierarchy of the system element, function, and failure representations of the FMEA
structure in a graphical format.

When you open the FMEA object and click the Structure Analysis, Function Analysis, or Failure
Analysis tab, a graphical view of the selected representation is displayed.

You can do the following:

* Show or hide the FMEA objects associated with the selected object. To do this, click Show More <.«
and then click =, =, or ’ icon in the tile.
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_ 16. Visualize the FMEA structure

The = icon indicates that there are objects at a higher level in the hierarchy.
The 7 icon indicates that there are objects at a lower level in the hierarchy.
Click the icons again to hide all the objects, except the selected representation.

Save the layout of the current view. After you save the current layout and change tabs or reopen
tabs the display changes to the default layout. To revert to the saved layout, click Apply Layoutand
select Fixed Layout.

If you perform any operation in a fixed layout, like adding or deleting an element or expanding the
next level elements, the node positions change and might differ from the saved node positions of the
saved layout.

If you add, modify, or delete any objects in the FMEA structure and revert to the saved layout, the
or |E icon on the tile indicates that the saved layout is partially loaded. You can click the icon and
select the required option to display the parent or child objects that were added after you saved the
layout.

Change the orientation of the net view. To do this, click Apply Layout and select the required option.

For Function Analysis and Failure Analysis, you can switch between the Net View and the Table
view if required.

Delete an object from the net view. To do this, right-click the tile and choose Delete. You can also
select the tile, and on the top toolbar, click Delete $¥.

Remove the next higher or lower level object associated with the selected object. To do this, select an
edge between any two nodes, and on the top toolbar, click Remove (-).

Edit the properties of an object. To do this, right-click the tile and choose Summary, or on the top
toolbar, click Summary. After editing, on the top toolbar, click Save Edits to save your changes.

Highlight the immediate connections or entire path. To do this, select the node and click Highlight £ .
Select Direct Connections 5~ to highlight the immediate connections to and from the selected node.
Select Entire Path == to highlight the entire path to and from the selected node.

Select corresponding higher or lower level nodes to move. To do this, select the node and click Select.

Sort function and failure analysis items in the net view by order number or tree hierarchy. To do this,
click Sort 7.

Pin a net view in a separate floating panel. To do this click Screen and select Pin Net View £=. All the
operations supported in the analysis tab are available in the pinned view.
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Add or modify objects in the net view _

* Focus on a specific area of the net view in the graphics window. To do this, click Show graphic
overview |r_and drag the cursor to focus on a specific area of the net view. To hide the graph view,

click Hide graph overview |-,.

Add or modify objects in the net view

You can add system elements, functions, and failure representations in the net view for and FMEA. You
can also add higher and lower level functions, and failure causes and effects in the net view.

1. Open the FMEA.

2.  Click the Structure Analysis, Function Analysis, or Failure Analysis tab as relevant.

3. Inthe netview, use one of the following methods to add the objects:

* Use the options available in the net view.

Overview History Structure Analysis

Boundary Diagram Interface Matrix  Attachments

Apply ) Summary (% Ops
Z%‘}Layo:t I:—T_—,, Add ﬁ Summary [ Cpen

* Select a tile and right-click to choose the required options.

Overview History Structure Analysis

Apply -
PRY I':-T—} Add .ﬁ? Sumimary E Op=n

& Layout

Boundary Diagram Interface Matrix

% Air Intake System
"9
-le ‘
®

@

Child

L J

Function

Surnmary

SIS

—% Air Filter assgnbly ..f,//g
i

% Turbocharger

» >
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* Use the options are available on the work area toolbar.

Maore...

Air Intake System @ child 2 New b
-
Owner: Ratnakar, Saurabh (sz
) Edit [
P Function g Edi

Overview  History  Structure 25 Mana 9

—_— Eﬂéﬂ Create Test ‘:/l% 9¢
o Share L4

Apply = Save T ! ate C 0
& Layout EE‘E Layout () Add .49 5 "r?":') Create hange

. @ View b

Create Trace Link

55 Import/Expart P
w Generate Control Plan L IMportExp

| Generate Trace Link Matrix

Generate Report

4. Click Save Edits [2) to save your changes.
Personalize a view

You can personalize the information displayed on each FMEA node such as system element, function, or
failure in the net view.

Example:

Personalize a failure analysis to display its severity and the associated system element in the net
view.
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Net View Settings

¥ Node View Template

o Personalize information which you wish to see
on each node.

¥ Failure
Severity
E] Classification

System Element

E] Function

¥ Action Group
E] Occurrence
[j Detection
E] Priority

¥ Expand Up to

@ Show additional node content in the viewable
area.

O Action Group

O Action

Apply Apply and Save

i

Personalize a view _

Procedure

1. Open the FMEA in the Tree view.

relevant.

3. Click Net View Settings dig, .

Select a node and click the Structure Analysis, Function Analysis, or Failure Analysis tab as

* From the Node View Template section, select the required options to display content in nodes

* From the Expand Up to section, specify the level up to which you want to display additional

4. Inthe Net View Settings panel, do the following:
in the net view.
content.

5.

To save the net view settings even after switching tabs, click Apply and Save, or click Apply to save
the net view settings temporarily until you switch tabs.
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Your administrator can configure the parameters available in the Net View Settings panel.

Specify the initial or revised prevention and detection actions in the net view

You can specify the initial state and revision state prevention and detection actions for failure
representations, failure causes, and failure effects. While specifying the prevention and detection
actions, you can add the actions from templates.

Procedure

1. Openan FMEA.

2. Select a failure representation associated with a function within the FMEA structure.
3. Click the Failure Analysis tab and select a failure cause or failure effect.

You can create prevention and detection actions for a failure cause. You can create preventive
action and detecyion action if your administartor has enabled the editing of these.

4. To add the action group, do one of the following:
* In the net view, click Add > Initial Action Group or Revision Action Group.
OR
* Right-click the tile and choose Initial Action Group or Revision Action Group.
The Initial State or Revision State action group is created in the tile.

5. Select the tile, and click Add, and select Prevention Action from template, Prevention Action,
Detection Action from template, or Detection Action.

6. Inthe Add Quality Action panel, specify a name.
7.  (Optional) Specify a description, a due date, owning project, and responsible user.

8. Click Add to create the quality action.

Save a current layout as a fixed view

You can save the current layout of the net view for structure analysis, function analysis, failure analysis,
process flowchart, or boundary diagram.
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Revert to the layout that is saved as a fixed view _

Procedure
1. Modify the layout to the orientation that you want to save for reference.
2. Inthe net view, click Save Layout o,
3. Inthe message box, click Save.
The current layout is saved as a fixed view.

After you save the current layout and change tabs or reopen tabs the display changes to the default
layout. You can revert to the saved layout whenever required.

Revert to the layout that is saved as a fixed view

After you save the current layout of the net view for structure analysis, function analysis, failure analysis,
process flowchart, or boundary diagram, and change tabs or reopen the current tab the display changes
to the default layout. You can revert to the saved layout using the Fixed layout option.

Procedure
1. Open the tab of the net view, boundary diagram, or process flowchart.
2. Choose Apply Layout > Fixed.

The display reverts to the saved layout.

If you add, modify, or delete any objects in the FMEA structure and revert to the saved layout, the
or |E icon on the tile indicates that the saved layout is partially loaded. You can click the

icon and select the required option to display the parent or child objects that were added after you
saved the layout.

Expand FMEA net views

You can now expand or collapse a selected tile in the FMEA net view. You can specify the structure level
up to which you want to expand the selected tile and expand all objects in the hierarchy.

Procedure

1. Open the FMEA and make sure you are in the Structure Analysis, Function Analysis, or Failure
Analysis tab.

2. You can do the following:

* Expand the tiles in the net view
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_ 16. Visualize the FMEA structure

Q

Select the tile, and click Expand N Levels.
b.  Select Higher Levels, Lower Levels, Effects, or Causes.

c. Inthe Expand to Level box, specify the number of levels up to which you want to expand
the net view

d. Click Expand.
The FMEA net view is expanded up to the specified level.
* Expand all lower level elements in the net view
a. Select the tile, and click .
b.  Click Expand All Lower Level Elements.
After expanding, click Hide Lower Level Elements to collapse the nodes.
* Expand all higher level elements in the net view
a. Select the tile, and click .
b.  Click Expand All Higher Level Elements.
After expanding, click Hide Higher Level Elements to collapse the nodes.

To collapse, on the tile click the ¥ icon and select Collapse.

Note:

Expanding or collapsing net views of FMEA structures that have more than 500 nodes may
take few more minutes than expected.

Edit the occurrence or detection values in the net view

You can edit the occurrence and detection values for all initial and revision state action groups.
Procedure

1. Open the FMEA object and navigate to the failure representation.

2.  Click the Failure Analysis tab.

3. Expand the failure to view the occurrence or detection actions in the net view.
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About the FMEA tree structure _

4. Select the tile and click Summary / to edit the values.

Owverview  History  Failure Analysis  Risk Analysis

Met
E Wiew

Apply o Ty Save Cancel —
Layout Drsd [Blge Bege [T e

o Leakage in air intake system

; Spyerity: B

q Conmny e

ﬁ:ﬂ] Pasmage of dean air without |eaiage
[ & w

Revision State
Oooumenoe: E
Detectiorr 4
Action Priarity:

rirtial State
L Ooormence: 4 '

Detertion

Ew

Revision Staﬂ

m

Muction Priority High

5. Modify the occurrence and detection values.

6. Click Save Edits [E) to save your changes.
Visualize the hierarchy of the FMEA in a tree structure

About the FMEA tree structure

The FMEA tree structure is a hierarchical representation of all the system elements, functions, failures,
and initial and revision states as well as their corresponding action groups. It also includes any external
system elements, functions, or failures in the FMEA.

The FMEA tree shows information about the FMEA objects, such as the sequence, structure level, release
status, attachments, their IDs, and the network information of functions and failures. For failures, the

Failure Mode and Effects Analysis, Teamcenter 2412 16-9
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_ 16. Visualize the FMEA structure

Network Information column shows the number of causes and effects linked to the failure, and for
functions, it shows the higher-level and lower-level functions linked to the function.

You can move structures within the FMEA tree by dragging and dropping them at the required level.
You can also modify the sequence of the system element representations, function representations, or
failure representations by updating the value in the Sequence column.

The following commands are available on the top toolbar in the Tree or Tree with Summary view:

Find - Search for any element in the FMEA tree structure. You can also refine your search results using
filters.

Expand - Expand or collapse the nodes in the FMEA tree structure.

Add - Add system elements, function, failure, action group, or actions to the selected element in the
FMEA tree structure

Specification - Replace the selected specification with the specified alternative.

Delete - Delete the selected system element, function, failure, action group, or action in the FMEA
tree structure.

Save Working Context - Save the current working view of the FMEA tree structure.
Restore - Restore the last saved working state.

Edit - Edit the value of the sequence of the elements. You can also double-click the cell and edit the
value.
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Add system elements, functions, or failures in the FMEA tree _
Air Intake System Design FMEA

Owner: Date Modified: 05-MNov-2023  Type: FMEA  FMEA Category: Generic  FMEA Type: Design
Tg Tree v ./ iil“’ JOfind (D) Expand (P add  §7 Fiters = Specification 3] Delers ch(
Name = Hidden Children = Sequence < Structure Level = ﬁ}
- :_:_ Air Intake System Design FMEA
I| - % Air Intake System 10 1
- f(@ Supply Clean and compress the ambient air 10 1
E@ Na Air to Engine 10 1
33@ Dirty air to engine 20 1
- % Air Filter Assembly 10 2
f(@ Filter the air to provide clean air 10 2
- % Air Filter Body 10 3
- f(@ Act as a reserveir of clean and compressed air 10 3
E@ Air Filter Leakage 10 3
» @ AirFilter Element 20 3
» @4 BoltMex3o 30 3
¥ @ Intake Snorkel 20 2
4 % Turbocharger 30 2
v @ Intake Manifold 40 2
4 % Connecting Hose 50 2
4 i External Failures

Add system elements, functions, or failures in the FMEA tree

You can insert FMEA objects above system elements, functions,or failures in the FMEA tree structure.
Procedure

1. Open the FMEA and make sure you are in the Tree view.

2. Select the system element, function,or failure in the FMEA tree structure.

3. Right-click the selection and choose Insert ®.
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Name = Sequence = Structure Level =
- Air Intake System 10 1
» f(@ Supply Clean and compress the ambient air 10 1
SE_ReleaseSaveAsActionGroupActions 5 3
b Air Filte “ = J 10 2
(7 Open
» intake <. @[5 ©P 20 2
Open in New Tab
4 Turbochan @ 30 2
|1? Open in New Window
4 Intake Mat 40 2
[ Open in Formsheet
v Connectin 50 2

f( F@ Copy
h
@ Passage | 10 2
2 é% Create Trace Link
* Leak 10 2
=5 (% Existing Trace Link
4 @ Ir Insert
@ Insert
» @ R Insert object above the selection

4. In the Create panel, search for an existing FMEA object or create a new one.

5. Click Create.

Move structures within the FMEA tree

You can move structures within the FMEA tree by dragging and dropping them at the required level
and reorganize the FMEA structure. When you move an object within the FMEA tree, all objects such as
system elements, functions, and failures inside the structure are also moved.

Procedure

1. Open the FMEA and make sure you are in the Tree view.
2. Select the node that you want to move.

3. Drag it to the required location in the FMEA tree.

The selected node along with any objects such as system elements, functions, and failures inside
the structure is moved.
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Save the current state of the FMEA tree structure _

Note:

You cannot move an FMEA node if there are system interfaces associated with it.

Save the current state of the FMEA tree structure

You can capture and save a snapshot of the current state of the FMEA tree structure. After you save a
current working state and expand or collapse the nodes in the FMEA tree to perform other operations,
you can revert to the saved state.

Procedure
1. Open the FMEA and make sure that you are in the Tree view.

2. On the work area toolbar, click Save Working State .

Revert to a saved state of the FMEA tree structure

After you save a current working state and expand or collapse the nodes in the FMEA tree to perform
other operations, you can revert to the saved state of the FMEA tree.

Procedure
1. Open the FMEA and make sure that you are in the Tree view.

2. Onthe work area toolbar, click Restore Saved State ).

Specify the sequence of FMEA objects

When you create the FMEA objects, the default value of the of the Sequence or Order property of

the first FMEA object that you create is 10. For the subsequent siblings that you create, the value is
automatically populated in increments of 10. You can edit the value of these properties and modify the
sequence of FMEA objects displayed in the Tree, Tree with Summary, or net view.

You can specify the order of the FMEA objects as follows:

* For FMEA objects such as system element representations, function representations, failure
representations, and actions, you can modify the value of the Sequence property.

The sequencing is maintained when you perform the Save As operation or create a new version of
the FMEA. In the formsheet view, the FMEA objects are ordered based on the ascending value of the
Sequence property.

* For higher level or lower level functions or failure causes and effects, you can modify the value of the
Order property available in the Table view of the Function Analysis or Failure Analysis tab.
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_ 16. Visualize the FMEA structure

* Modify the Sequence property in the Information panel.

If you edit the Sequence property in the Information panel, the tree view and net view may not
reflect your changes. You must switch to another tab and then switch to the net view or tree view to
view the FMEA as per the updated sequence.

Modify the sequence of system element representations, function representations, or
failure representations in the FMEA tree structure

To specify the order of FMEA objects in the tree structure, you can edit the value of the Sequence
property.

1. Open the FMEA object.
2. Expand the node of the FMEA object and its siblings that you want to reorder.

The default value of the Sequence property is populated based on the creation sequence.
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Specify the sequence of FMEA objects _
I Sequence & |

- @R AC- 10
- f(@ Act as a reservoir of compressed air |'_||;‘-" 10
. Air Filter Clogging 10

Ak Air Filter Leakage 20

f(@ Act as a reservoir of clean air 20

~ @& AirFilter Body 10
- f(@ Clean and compress the ambient air 10
dat, Air Filter Clogging 10

_E Air Filter Element tomn 20

_E Dirty air to engine 30

s, Air Filter Leakage 40

_E Engine not starting 50

.E Engine not starting 60

f(@ Wheel_Function 20

3 @J External Functions

3 fﬁ External Failures

3. Choose More commands «s« > Edit ./ > Summary

4. Inthe Overview tab, edit the value of the Sequence property to reorder the sequence as required.

5. Choose More commands -« > Edit ./ > Save Edits to save your changes.

The sequence of the FMEA objects is reordered as per the modified value of the Sequence
property. The sequencing is maintained when you perform the Save As operation, or create a

new version of the FMEA.

Failure Mode and Effects Analysis, Teamcenter 2412
© 2025 Siemens

16-15



_ 16. Visualize the FMEA structure

Tip:

If the tree structure does not reflect the modified sequence, you can collapse the node in the
tree structure and expand it again to refresh the view.

Mame = Sequence = {E}
*® .
- _._._ Air -6.1
~ @ AC- 10
- f(@ Act as a reservoir of compressed air 10
g@ Air Filter Clagging 10
g@ Air Filter Leakage 20
f( Act as a reservoir of clean air 20
~ W% AirFilter Body 10

- f(@ Clean and compress the ambient air 10

E@ Engine not starting 10
£® Dirty air to engine 20
& Air Filter Element torn 30
g@ Air Filter Leakage 40
g@ Air Filter Clagging 50
&@ Engine not starting 60
f(@ Wheel_Function 20

3 @J External Functions

2 ;ﬁ External Failures

Modify the sequence of higher level or lower level functions, and failure causes or effects
in the table

To specify the order of FMEA objects in the table, you can edit the value of the Order property.

In the Function Analysis net view, the Order property of the Lower Level Functions table is used for
arranging the nodes. The Order property from the Higher Level Functions table is not considered.
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Specify the sequence of FMEA objects _

In the Failure Analysis net view, the Order property from the Cause table is used for arranging the
nodes. The Order property from the Effect table is not considered.

1. Open the FMEA object.
2.  Click the Function Analysis or Failure analysis tab.
3. Click Table to switch from the default view to the table view.

The default value of the Order property is populated based on the creation sequence.

Overview History Function Analysis Requirements  Characteristics

Met —
Ed,., Emne

w+ NEXT HIGHER LEVEL FUNCTION

'

Name = Order =~
Function1_LinkActionGroupToCause 10

3 P
Act as a reservoir of clean air 20

&

Clean and compress the ambient air 30

3 F

4. In the Order column from the Lower Level Functions table for function analysis, or the Cause
table for failure analysis, double-click a cell to edit the value.

5. After you finish editing, make sure that you click outside the cell to save your changes
The sequence of the functions is reordered as per the modified value of the Order property.

If the table does not reflect your changes, you can switch to the net view and reopen the table view
to see the updated sequence.
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Overview  History  Function Analysis  Requirements  Characteristics

Met —
Ed... =Rl

W

 NEXT HIGHER LEVEL FUNCTION

Name *= Order =
@ Function1_LinkActionGroupToCause 10
f(@ Clean and compress the ambient air 20
f[:@ Act &z a reservoir of clean air 30

Replace a specification in the FMEA tree structure

You can replace an existing system element, function specification, or failure specification in the FMEA
tree structure.

Procedure
1. Open the FMEA and select the specification that you want to replace.
2. Click Specification ..

3. Inthe Replace panel, select the system element, function specification, or failure specification that
you want to replace the existing one with.

4. To update the name of the existing system element, function specification, or failure specification,
select the Update system element name based on selection check box.

If you do not select this check box, the name of the system element, function specification,
or failure specification remains the same, but the name of the associated specification object is
updated.

5. Click Replace.
Expand or collapse the FMEA tree structure

You can expand or collapse a selected node in the FMEA tree structure. You can expand the selected
node in the FMEA tree structure up to a specified structure level.
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Expand or collapse the FMEA tree structure _

Procedure
1. Open the FMEA and make sure you are in the Tree or Tree with Summary view.
2. Do the following:

* To expand a node in the FMEA tree structure, select the node, and click Expand > Expand

Below.
—
te[] Tree i‘;'EE SO rnd (&) Expand
Name = Expand Below
e @ Expand Below
- :_: Air Intake System Desig - Expand the selection.
() Collapse Below I
- -%5 Air Intake System 10
Expand to |
k f(@ Supply Clean anc Structure Level: ir 10
b @ Airfiter Assemb | | 10
¥ @ Intake Snorkel 20
b % Turbocharger 30
» @& Intake Manifold 40
4 -@5 Connecting Hose 50
b i External Failures

* To collapse a node in the FMEA tree structure, select the node, and click Expand > Collapse
Below.
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. Sel )
Bf] s v A: R eLI N E:pa"d Overview H

MName = | Camanns Chruartuirs AL

@ Expand Below

Collapse Below
- :: Air Intake System Desic I I
@ Collapse Eflow Collapse the selection. All levels under the selection are 4
- % Air Intake System U collapsed. ]
Expand to ] I T T ——
4 f(@ Supply Clean anc Structure Level: ir 10 1 Object
¥ @ AirFilter Assemb : 10 2
4 Intake Snorkel 20 2
% ¥ FILES
b % Turbocharger 30 2
Teble Y=
- f(@ Compress the clean air 10 2 B = '
- Required Boost Pressure not achieved 10 2 LT
sy

» @ Intake Manifold 40 2

* To expand a node in the FMEA tree structure up to a specified structure level:
a. Select a node in the FMEA tree structure, and click Expand.

b. Inthe Expand to Structure Level box, specify the structure level and press Enter.

TI:D'TrEE Va iﬁle‘t p Find @ Expand

.

Name = @ Expand Below

- :: Air Intake System Desig
@ Collapse Below

- % Air Intake System

Expand to ;
' f(@ Supply Clean anel cercture Level: 1

k % Air Filter Assemb 4]
k @ Intaks Snorkel

b Q Turbocharger

@ Intake Manifold

4 % Connecting Hose

¥ | A | External Failures

fal
Jut,  Engine not starting
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Modify the FMEA structure using filters _

The FMEA node is expanded up to the specified level.

ED'TEE 4 iﬁle{: p Find @ Expand

MName = Sequence = Structure Level =
e _:_2_ Air Intake System Design FMEA
- % Air Intake System 10 1
- f(@ Supply Clean and compress the ambient air 10 1
E@ Ma Air to Engine 10 1
&@‘ Dirty air to engine 20 1
~ @ AirFilter Assembly 10 2
- f(@ Filter the air to provide clean air 10 2
L E@ Air Filter Clagging 10 2
v @ AirFilter Body 10 3
L f(@ Act as a reserveir of clean and compressed air 10 3
v @ AirFilter Element 20 3
b fl@) Fiterthe sir 10 3
v @ Bolt M8X30 30 3
b f@) Tighten the air itter 10 3

Modify the FMEA structure using filters

In the FMEA tree, you can apply available filters to modify the FMEA structure using the options available
in the Filters panel.

For example, you can view all the failures in the FMEA structure that have a severity greater than 8.
The following procedure shows how to use filters such that FMEA tree view displays only those failures
whose severity value is greater than 8, and save the FMEA tree structure.

Procedure
1. Open the FMEA and click Filters /.
2. Inthe Filters panel, specify View = Failure, and Severity = Greater than 8.
The FMEA tree view displays only those failures whose severity value is greater than 8.

The View option in the Filters panel, helps you specify the objects that you want to display in the
tree.
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Option Description

View = System Element View only system elements in the FMEA tree.

View = Function View system elements with functions in the FMEA tree.

View = Failure View system elements with functions and their associated failures in the
FMEA tree.

View = Quality Actions View system elements with functions and their associated failures and
actions in the FMEA tree.

After you apply the filters, you can choose Save Working State b to save the current state of the
FMEA structure. You can modify the severity of all failures as required. You can then choose Restore

Saved State ) to revert to the saved state.

Search for and filter the search results in the FMEA tree structure

You can search for objects in the FMEA tree structure. You can also use filters to narrow down the search

results.

Procedure

1. Open the FMEA and make sure you are in the Tree view.

2. On the work area toolbar, click Find ©.

Air Intake System Design FMEA

Owner:

T::D Tree v iﬁlec‘. p Find @ Expand

MName
Find

Find an object in the FMEA tree structure.

~ % Alr Intake System

g@ Mo Air to Engine

At Dirty air to engine

Date Modified:

- f@ Supply Clean and compress the ambient air

1

3. Inthe Find panel, enter the search keywords and press Enter or click ©.

You can use wild card characters to search for the objects in the FMEA tree structure.
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Air* > O

Results Filters

¥ RESULTS (22)

Air Intake System

Chwhner:
Date Modified: 12-Oct-2022 12:05

Air Filter Assembly

Chwner:
Date Modified: 11-Cct-2022 01:36

Air Filter Body

Chwner:
Date Modified: 11-Cct-2022 01:36

Air Filter Element

Chwner: . . . I
Date Modified: 11-Cct-2022 01:36

&8 88

The Results tab displays the search results.
4. To filter the search results, click the Filters tab.

5. Select the required filter criteria.

Failure Mode and Effects Analysis, Teamcenter 2412 16-23
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_ 16. Visualize the FMEA structure

‘ Air* X O

Results Filters

E] System Element

Function

E] Failure

E] Quality Action

When you switch back to the Results tab, the search results are filtered as per the specified filter
criteria.
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Ajr* ey

Results Filters
¥ RESULTS (9)

Provide ambient air to air filter
( Chwner: ] ) )
Date Modified: 11-Oct-2022 01:36
Act as a reservoir of clean and co...
f( Chwner: ) i )
Date Modified: 11-Oct-2022 01:36
Supply Clean and compress the a...
f( Chwner: ] ) )
Date Modified: 11-Oct-2022 01:36

Act as a reservoir of clean air

f( Cwner: | I
Date Modified: 11-Oct-2022 01:36

6. Click Close to close the Find panel.

Failure Mode and Effects Analysis, Teamcenter 2412 16-25
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17. View the FMEA data in the formsheet

About FMEA formsheets

You can view the FMEA data of a system element representation, such as failure effects, failure causes,
and other related actions in the formsheet. While creating FMEA objects, you specify the failure analysis
mode type as process FMEA or design FMEA and specify the guidelines associated with them. FMEA
provides guidelines based on the AIAG & VDA, IATF 16949, AS13004, and AS13100 industry standards.
These guidelines are linked to a configuration file, which is used to render the Formsheet view.

You can open the formsheet in one of the following ways:

* Open the Formsheet view on the top toolbar. When you open the formsheet using this method, it
opens in full mode that contains information about the systems, subsystems, and components, and
the entire hierarchy of the FMEA that is analyzed.

Date Modified: 05-Mov-2023

n te Tree v ./ iled p Find @ Expand () Add ? Filters

Formsheet

Assistant e Formsheet
) -

* Right-click a system element and choose Open in Formsheet in the Tree view. When you open the
formsheet using this method, it is displayed in a new browser tab in the Lite mode which displays
information specific to the focus element only.

Display objects in a formsheet view.
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_ 17. View the FMEA data in the formsheet

Air Intake System Design FMEA

Name *

Owner: Ratnakar, Saurabh (saurabhr)

IEE Tree ~ | ./ iﬁlea p Find @ Expand (—B Add

Date Modified: 05-Nov-2023

h :: Air Intake System Design FMEA

“‘1:'(” Filters %_> Specification

Hidden Children

b @ Air Intake System

- f(@ Supply Clean

% No Airto E

% Dirty air to

4 @ Air Filter Assel

4 % Intake Snorkel

4 @ Turbocharger

4 @ Intake Manifo

4 @ Connecting Hi

P | Al i
N External Failures

Open
Open in New Tab

Open in New Window

Open in Formsheet

Add

Delete

Copy

Create Trace Link
Existing Trace Link

Specification

»

Open in Formsheet

Open the selection in Formsheet View in a new browser tab.

Type: FMEA

2% Delete

Save
Worki...

Sequence =

10

10

10

20

30

40

50

Structur

2

Note:

Summary view.

The Lite mode is not available in the Formsheet view. It is available only when you open the
formsheet using the Open in Formsheet right-click menu option in the Tree or Tree with

In the formsheet, you can perform basic actions such as creating system element representations,
creating function representations, or associating failure effects and failure causes to failure

representations.
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+ Air Intake System Design FMEA O (8 noncawercn) | O .. @  SIEMENS
Owner: Date Modified: 05-Nov-2023  Type: FMEA More... [} g © @
= Formsheet ~
7 Filte: Print Lite Modh Rows per 7 Fll
C refresh N7 Fber  (ZI T L 0 @D vievode ‘ 25 = e
¥ Formsheet Header o
DESIGN FAILURE MODE AND EFFECTS ANALYSIS (DESIGN FMEA)
PLANNING AND PREPARATION (STEP 1)
sl E M E N s Company Name BMW Subject Air Intake System Design FMEA DFMEA ID Number FMEA-000000008 / 1
Engineering Location Pune DFMEA Start Date 11/5/2023 2:03:18 PM Design Responsibility
Customer Name Sogefi DFMEA Revision Date 11/5/2023 2:03:18 PM Confidentiality Level Business Use
Model Year/Platform 2021-22 / Passenger Cars Cross Functional Team

STRUCTURE ANALYSIS (STEP 2)

FUNCTIONAL ANALYSIS (STEP 3)

1. Next Higher Level

2. Focus Element

3. Next Lower Level

1. Next Higher Level Function

2. Focus Element Function and
Requirement or Characteristic

3. Next Lower Level Function

Failure Effects (FE)

Air Filter Assembly

Intake Snorkel

Act as a reservoir of clean and
compressed air

Provide ambient air to air filter

Engine not starting

Supply Clean and compress the

Turbocharger ambient air

Air Intake System Compress the clean air

DE

Next b

1 Commands in The formsheet has the following commands:
the

formsheet * Refresh - Refreshes the display of the formsheet after you have made updates.

* Filter - Allows you to apply filters on different columns in the formsheet to narrow
down the search results.

* Print Formsheet - Lets you download and print the formsheet data to an HTML
file.

* Edit > Header - Allows you to edit the information in the header.

* Edit > Cross Functional Team - Lets you update the information regarding the
cross functional team that is performing the FMEA.

* Lite Mode - This mode available only when you open the formsheet using the
Open in Formsheet right-click menu option in the Tree view. It displays the
information with respect to the functions, failures, and actions of the focus system
element. The information about its children is not shown. In large formsheets, this
helps you to work with smaller chunks of data.

The Print Formsheet command is not available in the Lite mode.

* Rows per Page - Lets you specify the number of rows that you want to display on
each page in the formsheet.
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_ 17. View the FMEA data in the formsheet

* Full Screen - Displays the formsheet in the full screen mode.

2 Formsheet The formsheet header row displays information about the planning and preparation
header step of the FMEA such as the company name and company logo, the start and
revision date of the FMEA, and the cross functional team. The formsheet header row
is collapsed by default.

3 Columns The formsheet columns display information about each step in the FMEA. You can
show or hide these columns, or apply filters as required.

You can open FMEA objects from within the formsheet. To do this, right-click a cell in
the formsheet and click Open [¢}.

View the formsheet for the FMEA data

1. Open an FMEA object.

2. Switch to the Formsheet view.

Date Modified: 05-Mov-2023

Y 'EE Tree ~ ./ ijlea p Find @ Expand (1) Add ? Filters

Formsheet

Assistant e Formsheet
) s

The Formsheet view displays the complete FMEA data, including system element representations,
function representations, failure representations, failure causes, failure effects, requirements,
characteristics, initial and revision action groups, the occurrence and detection values, severity,
prevention and detection actions, and so on.

Display objects in a formsheet view.

You can add, edit, filter, or delete the data in the formsheet view. You can also download and
share the FMEA data of the selected system element.
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Add FMEA objects in the formsheet view _

Add FMEA objects in the formsheet view

You can add system elements, functions, failures, requirements, characteristics, failure causes, failure
effects, initial and revision action groups, and prevention and detection actions to the formsheet data in
the formsheet view for design and process FMEAs.

Procedure
1. Open the FMEA and switch to the Formsheet view.
2. Do one of the following:
Add system elements or functions in the formsheet view
a. Select a cell that corresponds to a system element representation.

b.  Right-click the cell and choose Child or Function.

» Select —
E Formsheet ./ Al p Find

() ada  §7 Fier

» FORMSHEET HEADER

STRUCTURE AMALYSIS (STEP 2)

|
1. Mext Higher Level T‘i- Open in New Tab 3. Next Lower Level
P Child
Ii-F‘ Function
Air Filter Body
_ 7% Delete —
Air Intake System Air Filter Element
Bolt MEX30
Air Intake System Turbocharger

OR
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_ 17. View the FMEA data in the formsheet

Click Add and select Child or Function.

() ada  T7 Fier
gﬁj Child

I';-B‘ Function

Calmcs
B rormsheet ;‘:IE{' p Find

DER

STRUCTURE AMNALYSIS (STEP 2)

1. Next Higher Level

Air Intake System

2. Focus Element

Intake Snorkel

Air Filter Assembly

Note:

If you select a cell that represents a child system element representation, you will also
see the Sibling option.

c.  Enter the required properties in the Create panel and click Add.

Add functions, failures, requirements, or characteristics in the formsheet view

a. Select a cell that corresponds to a function representation.

b.  Right-click the cell and choose the required option.
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E Formsheet i‘;IE‘I p Find

() ada  T7 Fiter

» FORMSHEET HEADER

FUNCTIONAL ANALYSIS (STEP 3) Open in New Tab

2. Focus Element Function and R
Mext Lower Level Function
Requirement or Characteristic |

() Mext Higher Lavel Function
) Requirement
Filter the air to provide clean air () Characteristic
#% Delete
[ i
OR
Click Add and select the required option.
Failure Mode and Effects Analysis, Teamcenter 2412 17-7
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_ 17. View the FMEA data in the formsheet

C.

Select )
E Formsheet Al é:::l Find

() ada = 7 Fier

J

I’;—T—j Failure

I’;—T—j Mext Lower Level Function

@

Mext Higher Level Function

@

Reguirement

Characteristic

@

FUNCTIOMAL ANALYSIS (STEP 3)

2. Focus Element Function and
Requirement or Characteristic

ambient air

Supply Clean and compress the
ambient air

Filter the air to provide clean air

Note:

see the Sibling option.

If you select a cell that represents a child system element representation, you will also

Enter the required properties in the Create panel and click Add.

Add failure causes and failure effects in the formsheet view

a.

b.

Select a cell that corresponds to a failure mode.

Right-click the cell and select Failure Effect or Failure Cause.
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Add FMEA objects in the formsheet view _

Select )
E Formszheet Al p Find

(B Ada 7 Fiter

» FORMSHEET HEADER

FAILURE ANALYSIS (STEP 4)

Severity (S) | Failure Mode (FM) of the Focus o - s
of (FE) Element @ Open in New Tab stic
1 IET_—] Failure Effect
&
_ IET_—] Failure Cause N
2% Delete
8 Air Filter Clegging X

OR

Click Add and select Failure Effect or Failure Cause.

Select §
E Formsheet Al p Find

() ada 57 Fier

% Failure Effect R

& Failure Cause

Y515 (STEP 4)

Severity (5) | Failure Mode (FM) of the Focus
of (FE) Element

c.  Enter the required properties in the Create panel and click Add.
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_ 17. View the FMEA data in the formsheet

Add initial and revision action groups in the formsheet view

a. Select a cell that corresponds to a failure cause.

b.  Right-click the cell and select Initial Action Group or Revision Action Group.

[ =
E rormsheet 7 ;‘;IE{' p Find

l:_-E' Add l:_:_}' Remaowe ‘? Fileer

» FORMSHEET HEADER

Failure Cause (FC) of the Next
Lower Element of Characteristic

Current Prevention Control (PC)
of FC

Water in Air Filter Element

Position of Snorkel defined as per
guidelines

Leakage in air intake system

Air Filter Leakage

&

Open in New Tab

OR

Intital Action Group

L]

i

D

S

Revision Action Group

i

Remaove

(I-_:'II

X

Delete

Click Add and select Initial Action Group or Revision Action Group.
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Select }
E Formsheet Al p Find

(—B Add @ Remaowve ? Filtar

Y

@) Intital Action Group

() Revision Action Group

Failure Cause (FC) of the Mext Current Prevention Control (PC)
Lower Element of Characteristic of FC

Water in Air Filter Element Position of Snorkel defined as per

guidelines

Leakage in air intake system

Clamping Specification as per 15
standard

c.  Enter the required properties in the Create panel and click Add.
Add prevention and detection actions to the action groups in the formsheet view
a. Select a cell that corresponds to the occurrence or detection value for the failure cause.

b.  Right-click the cell and select Prevention Action or Detection Action.

Failure Mode and Effects Analysis, Teamcenter 2412 17-11
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(= ’
E rormzheet ¢ ;‘;IE{' p Find

() Ada  §7 Fiter

» FORMSHEET HEADER

RISK AMALYSIS (STEP 5)

Current Prevention Control (PC)
of FC

Occurrence
(0) of FC

Current Detection Controls (DC)
of FC or FM

Position of Snorkel defined as per
guidelines

OR

™

(4} Prevention Action

IEB' Detection Action

PR

Click Add and select Prevention Action or Detection Action.
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_ s Selact =
EF:}rrnﬁh:Et A Al p ind

() Ada 57 Filter

-

-'4_ . -
'd—“ Prevention Action

(' Detection Action

RISK AMALYSIS (STEP 5)

Current Prevention Control (PC) | Occurrence Current Detection Controls (DC)
of FC (0} of FC of FC or FM

Initial State

Position of Snorkel defined as per

- . LRl = II\ hi L=
Shower Test on Vehicle
guidelines

| IS T [ o I

c.  Enter the required properties in the Create panel and click Add.

Edit the data in the formsheet view

You can edit the data that is displayed in the formsheet.

Procedure

1. In the Formsheet view, double-click a cell to switch to the edit mode.
2. Modify the contents of the cell as required.

3. Click Save Edits [Z) to save your changes.

Remove the data in the formsheet view

You can remove data in the FMEA formsheet. When you remove an object from the formsheet, the
system removes the relation of the object with the formsheet.

Procedure

1. Open the FMEA and switch to the Formsheet view.
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2. Select the cell that corresponds to the data that you want to delete, and do one of the following:
* Right-click the cell and choose Remove (.

* In the formsheet, click Remove (-).

Delete data in the formsheet view

You can delete the data in the FMEA formsheet view.

Procedure

1. Open the FMEA and switch to the Formsheet view.

2. Select the cell that corresponds to the data that you want tot delete, and do one of the following:
* Right-click the cell and choose Delete <.

* In the formsheet, choose Delete $¥.

Hide or show the columns in the formsheet
You can hide the columns in the formsheet view and show them as required.
Procedure
1. Open the Formsheet view.
2. Do one of the following:
To hide a column in the formsheet
a. Navigate to the column that you want to hide.

b. Inthe column header, click Hide «.
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- ¢, Select -
EF:}rms,h:Et ol p ind

7 Filter

» FORMSHEET HEADER

STRUCTURE AMALYSIS (STEP 2)
1. Mext Higher Level @ 2. Fodus Element

Hide

é

Air Intake sytem Air Filter Assembly
Air Filter Assembly Air filter Body
Air Filter Assembly Air Filter Element
Air Filter Assembly Bolt MEX30

A % next to the column header indicates that the column next to it is hidden.
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_ s Select _
E Formsheet ./ Al p ind

7 Filter

» FORMSHEET HEADER

STRUCTURE AMALYSIS (STEP 2)

2. Focus Element 3. Next Lower Level

Air Filter Assembly Bolt MEX30

Air filter Body

Air Filter Element

Bolt MEX30

To show a hidden column in the formsheet
a. Navigate to the column that you want to show.

A % next to the column header indicates that the column next to it is hidden.
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; Select .
E Formsheet .~ Al p Find

%7 Filter

» FORMSHEET HEADER

STRUCTURE AMALYSIS (STEP 2)

2. Focus Element 3. Next Lower Level

| Hidden Colurmni(s) Bolt MBX30

Air filter Body

Air Filter Element

Eolt MEX30

b.  Click » and select the name of the column that you want to show.

= FORMSHEET HEADER

STRUCTURE ANAL

2. Focus Element

N 1. Mext Higher Level
Column Chooser —r
Air filter Body

The hidden column is displayed.

To show or hide multiple columns in the formsheet
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a. Navigate to a hidden column and click 7.

b. Select Column Chooser.

» FORMSHEET HEADER

STRUCTURE ANALYSIS...

NN

2. Focus Element

R R R R R

1. Mext Higher Level

Colurmn Chooser —

Air filter Body

Air Filter Element

Bolt MEX30

c. Inthe Column Chooser box, specify the columns that you want to show or hide.

Column Chooser

Reset

show 1. Mext Higher Level Function
Hiiﬁ’j 2. Focus Element Function and Requirement or CIT:
Hide 3. Mext Lower Level Function
Hide  Failure Effects (FE)
Hide  Sewverity (5) of (FE)
Apply Cancel
d. Click Apply.
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Filter data in the formsheet

You can filter data in one or multiple columns in the formsheet. When you print the formsheet data to an
html file, you can specify if you want to retain the layout of the formsheet as per the filter criteria.

Procedure

1. Open the FMEA and switch to the Formsheet view.

2. On the top toolbar, click Filter T7.

3. Inthe Filter panel, select a name from the Column Names list.

4. Select the criteria from the available options, or specify the filter criteria as required.
5. Click Add.

6. Repeat steps 3- 5 to specify multiple filter criteria.

You cannot apply multiple filters to the same column.

Note:

* To delete a filter click Remove Filter < in the Filter panel.

¢ To remove all filters, click Clear All.

7.  Click Apply to filter the formsheet data per the filter criteria that you have specified.

A 57 icon in the column header indicates that the data is filtered.
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; Select .
E Formsheet o Al p Find

57 Fier () i:f"’

» FORMSHEET HEADER

FAILURE ANALYSIS (STEP 4)

Severity (5) | Failure Mode (FM) of the Focus
of [FE Element

a Air Filter Clogging

a Air Filter Leakage

-] Air Filter Element torn

g Water in Air Filter Element

a cosening of air filter bolts

Note:

To clear all the filters applied to the formsheet data, on the top toolbar, click Clear All Filters

.

Download and share the FMEA formsheet data

You can generate and share an html file or an xIsx file that contains the formsheet data of the selected
FMEA object. For example, you can share the risk assessment with third parties if required.

Procedure

1. Open an FMEA object.

2. Switch to the Formsheet view.
3. Do one of the following:

* In the formsheet, click Print Formsheet .
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OR
* Choose More Commands ««« > Share < > Print Formsheet.
In the Print Formsheet panel, specify the number of pages you want to print.
From the Report Format list, select HTML or MS Excel.

To print the formsheet by retaining any filters applied in the formsheet view, select the Apply
current Filters for print check box.

The check box is available only if filters are applied to the formsheet data.
Click Print.

You can download the html or xIsx file and share it as required.
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18. View audit logs for FMEA objects

Audit logs for FMEA objects

You can access audit logs for system elements, functions, failures, and quality actions.
The audit logs provide the information about the following events:

Create

Indicates that the object is newly created.
Modify

Indicates that the properties of the object are modified.
Attach

If you add child objects to an FMEA object, the modification is recorded as an Attach event in the
audit logs. If you move an FMEA object from the current parent object to another, the modification is
recorded as an Attach event for the new parent object.

Detach
If you move child objects from one FMEA object to another, the modification is recorded as a Detach

event in the audit logs.

The Workflow Logs table provides detailed information about specific workflow events for each FMEA
object.

For more information about each logged event, you can select the event and click Information (i). The
Information panel provides detailed information about the changes made.

Note:

Your administrator must set up preferences and configure Audit Manager in BMIDE so that you
can view audit logs for FMEA objects.

View audit logs for FMEA objects

You can view audit logs for system elements, functions, failures, and quality actions in the FMEA, or the
FMEA variants.

Prerequisites

Your administrator must configure Audit Manager in BMIDE so that you can view audit logs for FMEA
objects.
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Procedure

1. Open the FMEA and select the required system element, function, failure, or quality action whose
audit log you want to view.

2. Click the Audit Logs tab.

The General Logs table lists displays the logged date, the event type name, user ID, group name,
and other details.

The Workflow Logs table displays the workflow-related actions that have been performed for the
FMEA object.

3. (Optional) To view additional information, select an event and click Information (i) > All
Properties tab. The Information panel displays the old values and the new values of the fields
that are modified.
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19. Using an FMEA as reference to create
other quality tasks

After you have identified the failure modes for a design or a process using the FMEA methodology, you
can do the following to create other quality-related tasks and issues using the FMEA or the findings as
reference:

» Create a quality issue to investigate a potential problem that must be addressed. You can capture
issues in various forms of complaints, defects, or non-conformance that inconvenience customers.

» Create a control plan to trim down the design or process inefficiencies by identifying their sources and
monitoring them. This can help you to further minimize the process and product variation, decrease
product development time, and the associated costs.

The Control Plan tab displays a history of all the control plans that are created using an existing FMEA
as reference.

Note:

A separate license is required to create Quality Issues and Control Plans respectively.

O (B Noaawec. ) @ .. SIEMENS

. & Owner: Date Modified: 01-Oct-2023  Type: FMEA More... = 0 M © BH @ My e
d
, Select - . -
FA T Tree v TF Find L Edn wee :::: Air Intake System Design FMEA & & Edit || D]
ul
i Owner: Date Modified: 01-Oct-2023 More...
Componen. ETNIEIN & A
anj - :: Air Intake System Design FMEA Overview  History = FMEA Linkages  Attachments | Control Plan
ome —
- Air Intake System
2 e@ ¥ ¥ Control Plan History
Assistant
4 f(@ Supply Clean and compress the ambient a
s wil Select = o
(=R bl
Discussions 4 a‘s Ar Filter Assembly
MName = D = Revision < Control Plan Type +
N 4 a‘s Intake Snarkel {%
Folders - #E Air Intake System Desig..  CP-000003 A Production
4 (& Turbacharger
Inbox Y@ Intake Manifold
& 4 a@ Connecting Hose
Programs N
* | & External Failures
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